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               ekilas Tentang Microsoft Excel 
 

Microsoft Excel adalah salah satu produk perangkat lunak pengolah data 

dari Microsoft dalam bentuk lembaran tabel yang tersebar (spreadsheet). 

Perangkat lunak ini merupakan bagian dari paket perangkat lunak Microsoft Office 

yang di dalamnya terdapat banyak perangkat lunak (keperluan perkantoran) 

misalnya: Microsoft Word (pengolah kata), Microsoft Power Point (untuk keperluan 

presentasi),  dan Microsoft Access (untuk keperluan basis data). 

Microsoft Excel digunakan untuk mengolah berbagai jenis atau tipe data 

misalnya data nilai pelajaran siswa yang berarti jenis datanya numerik, data teman 

dan nomor telepon yang berarti jenis datanya teks, data rekapitulasi pemakaian 

barang dalam bentuk angka dan teks, dll. Dalam Excel selain bisa digunakan 

untuk mencatat dan menyimpan data-data tersebut, Excel juga mampu melakukan 

perhitungan penjumlahan, perkalian, fungsi-fungsi logika, perhitungan rata-rata, 

bahkan sampai pembuatan grafik.  
 

               
             enjalankan Program Microsoft Excel  

 
Ada beberapa cara untuk menjalankan atau memulai program Microsoft 

Excel. Pertama kita bisa memulainya dengan klik ganda pada icon shortcut yang 

telah kita buat sebelumnya pada desktop.  
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Gambar 1. Icon shortcut Microsoft Excell di desktop 
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Icon shortcut Microsoft Excel tampak seperti Gambar 1 di atas. 

Cara kedua adalah lewat start menu dengan langkah-langkah sebagai berikut 

(Perhatikan Gambar 2):  

1. Klik tombol Start 
2. Pilih menu Programs  
3. Klik Microsoft Excel 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 2. Menjalankan Excel lewat tombol Start 

 
Selanjutnya di layar monitor akan muncul selama beberapa detik tampilan 

splash window dari Excel seperti berikut. 

 

 

 

 

 

 

 

 

 

 
Gambar 3. Tampilan splash window dari Excel 
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Kemudian muncul tampilan jendela utama dari Excel seperti gambar berikut ini.  

 

 

 

 

 
Gambar 4. Jendela utama dari Microsoft Excel 

 

Perhatikan Gambar 4 di atas. Keterangan dari tiap-tiap bagian jendela 

utama Microsoft Excell adalah seperti telah ditampilkan dalam Gambar 4. Untuk 

memulai memasukkan atau mengetikan data dapat langsung diketikkan lewat 

keyboard dan data yang diketikkan akan muncul dan berada di cell yang aktif saat 

itu. Cell yang aktif dapat dipilih dengan menggerakkan pointer cell aktif 

menggunakan tombol panah atas, bawah, kiri dan kanan, atau langsung dengan 

menunjuk cell yang diinginkan aktif menggunakan mouse, lalu klik kiri sekali. 

 

 

 

 

 

Nama Dokumen 
(Workbook) 

Toolbar Standard 

Title Bar 

Name 
Box 

Menu 
Bar 

Worksheet yang ada di
dalam Workbook 

 

Sel Aktif 
(Pointer) 

Formula 
Bar 

Scroll Bar 

Kolom 

Toolbar 
Formatting 

Baris 



 

 

          perasi Dokumen dalam Excel  

 
1. Menyimpan Dokumen 

Data yang telah dituliskan dalam worksheet Excell supaya tidak hilang 

harus disimpan dalam dokumen (file). Penyimpanan dokumen bisa dilakukan 

dalam beberapa cara. Cara pertama adalah dengan langsung mengklik tombol 

save     di toolbar standar Excel. Jika ini adalah kali pertama penyimpanan 

dokumen maka akan muncul kotak dialog Save As seperti Gambar berikut. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 5. Kotak dialog Save As dari Excel 
 
 

Ketikkan nama dokumen pada File name dengan ketentuan pemberian nama 

dokumen maksimal 254 karakter tanpa tanda kutip (dalam contoh kasus ini nama 

file latih1). Lalu tentukan folder tujuan penyimpanan dokumen dari Save in, 

kemudian klik tombol                       .  

 
 Dengan kotak dialog Save As ini anda juga dapat melakukan penggantian 

nama dan folder tempat tujuan penyimpanan dokumen. 
 Dokumen program Excel (secara default) akan disimpan dengan ekstensi  

.xls 
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Cara kedua adalah dengan melalui menu File. 
 Pilih Save As saat penyimpanan dokumen pertama kali atau untuk menyimpan 

dalam file yang lain (namanya berbeda) jika dokumen sudah disimpan dengan 

nama file tertentu.  

 Pilih Save untuk penyimpanan selanjutnya (sudah diberi nama file). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 6. Penyimpanan dokumen lewat menu File. 

Ketika penyimpanan pertama kali (Save as) maka akan muncul kotak dialog Save 
As seperti Gambar 5 di atas dan langkah selanjutnya adalah sama seperti ketika 

anda mengklik tombol save di atas. 

 

2. Membuka Dokumen yang telah Tersimpan   
Guna membuka dokumen yang telah tersimpan dapat dilakukan dengan 

mengklik langsung  tombol Open           yang terdapat pada toolbar Standard, 

atau cara lain lewat menu File, lalu pilih Open. Maka segera akan tampil kotak 

dialog Open seperti Gambar 7.  

Langkah selanjutnya untuk membuka sebuah dokumen Excel adalah: 

 Masih dalam kotak dialog Open, tentukan atau arahkan folder tempat 

penyimpanan dokumen yang akan dibuka dengan cara memilih lewat combo 

box Look in. Perhatikan Gambar 7 berikut. 

Microsoft Excel 6



 

 

 

 
Gambar 7. Combobox Look in untuk mencari atau mengarahkan direktori 

 

 Pilih dokumen yang akan dibuka dengan langsung klik ganda file tersebut atau 

dengan klik tombol Open setelah dokumen yang akan dibuka telah disorot. 

 Segera isi dokumen Excel tersebut akan dibuka oleh program Excel 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 8. Membuka Dokumen 
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3. Menutup Dokumen atau Mengakhiri Excel    
Untuk menutup dokumen yang sedang dibuka tanpa mengakhiri program Excel, 
lakukan dari menu File pilih Close.  Atau dengan mengklik tombol Close Window  

       di pojok kanan atas jendela workbook (di bawah tombol Close). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar  9. Menu untuk menutup dokumen Excel tanpa mengakhiri Excel 

 

Untuk menutup dokumen sekaligus mengakhiri program Excel, dilakukan dari 

menu File, pilih Exit atau klik pada icon Close        yang terdapat pada tepi kanan 

Title Bar. 
 

4. Mencetak Dokumen    
Pada satu worksheet Excel, mungkin terdapat beberapa tabel atau grafik, 

anda dapat mencetak semuanya atau bagian tertentu saja. Jika anda akan 

mencetak grafik atau tabel tertentu maka mulailah dengan mem-blok tabel atau 

grafik yang akan dicetak, tetapi bila anda ingin mencetak semuanya pengeblokan 

tidak diperlukan. 

Untuk mencetak melalui menu File pilih Print (atau dengan menekan 

Ctrl+P). Maka segera akan tampil kotak dialog Print (Gambar 10). Dalam kotak 

Close 
Window



 

dialog Print tersebut ada beberapa parameter dan isian penting yang perlu 

diketahui berkaitan dengan operasi pencetakan dokumen ke printer adalah: 

 Name, harus terisi sesuai dengan driver printer yang akan digunakan untuk 

mencetak dokumen. 

 Number of copies, guna menentukan jumlah kopi cetakan tiap lembar. 

 Pada Print range, pilih All jika akan mencetak semua halaman, atau pilih 
Page(s) jika akan mencetak halaman tertentu saja. 

 Pada Print what 
 Selection, guna mencetak bagian yang diblok saja. 

 Active sheet(s), mencetak semua tabel dan grafik yang terdapat dalam 

worksheet yang sedang aktif saat itu. 

 Entire workbook, mencetak semua worksheet yang ada. 

 Klik OK untuk memulai pencetakan. 

 

 
Gambar 10. Mencetak Dokumen 

 

Sebelum melakukan operasi pencetakan dokumen ke printer disarankan untuk 

melakukan Print Preview           terlebih dahulu. Print Preview adalah salah satu 

fasilitas dari Excel yang digunakan untuk melihat tampilan yang akan dihasilkan 

(preview) oleh cetakan printer. Jadi dengan print preview ini kita bisa melihat 

kira-kira hasil cetakan nanti sudah sesuai dengan keinginan kita atau belum, 
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mungkin ada bagian baris atau bagian kolom dari worksheet yang belum ikut 

tercetak akan kelihatan lewat print preview ini dan kita segera bisa membenahi 

(tanpa harus mencetak ke printer terlebih dahulu). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar  11. Tampilan Print Preview dengan kotak dialog Page Setup. 

  

 

          ENGENAL WORKSHEET  

 
Pada kondisi standard, tiap Workbook terdapat 3 sheet. Kita dapat melakukan 
pengaturan pada worksheet yaitu dengan menentukan jumlah worksheet dan 
mengganti nama worksheet. 
 
1.  Menentukan Jumlah Worksheet pada Tiap Workbook. 

 Dalam lingkungan Excell, pilih dan klik menu Tools 
 Pilih Option 
 Klik tab menu General 
 Isikan jumlah sheet yang dikehendaki pada Sheets in new workbook: dapat 
diisikan mulai 1 s/d 255 

 Akhiri dengan klik OK. 
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2.  Mengganti Nama Sheet 
Worksheet yang ditampilkan di dalam workbook secara default diberi nama oleh 
program Excel sesuai dengan urutan sheet-nya yakni mulai dari sheet1, sheet2, 
sheet3 dan seterusnya. Kita dapat mengubah nama sheet sesuai dengan 
keinginan kita (biasanya sesuai dengan jenis data yang kita buat di dalamnya) 
dengan langkah-langkah sebagai berikut: 

1. Klik kanan pada lokasi nama sheet yang akan diganti. 
2. Pilih dan Klik menu Rename. 

 
 
 
 
 
 
 
 
 
 
 
 

Gambar 12. Langkah-langkah mengubah nama worksheet 
 

3. Ketik nama sheet yang baru lalu tekan Enter. 
 
3.  Kolom, Baris, Sel dan Range 
Kolom adalah bagian di atas worksheet yang memanjang secara horizontal dari 
kiri ke kanan. Dalam tiap sheet kolom diberi nomor dengan abjad yaitu A sampai 
dengan IV yang berjumlah 256 kolom. 

 

 

 

 

 

 

 

 

Gambar 13. Mengatur lebar kolom 

 

1. Klik 
kanan 

Drag ke kanan untuk 
melebarkan atau ke kiri 

untuk menyempitkan kolom



 

 
Baris adalah bagian yang terletak di sebelah kiri worksheet dengan arah vertical 

dari atas ke bawah. Baris diberi nomor dengan angka 1 sampai dengan 65536. 
Sel adalah koordinat atau pertemuan antara kolom dan baris yang dinyatakan 

dengan nomor kolom dan nomor baris. Contoh jika pointer berada pada kolom H 
baris 5, maka dinamakan dengan sel Sel H5. 

Range merupakan sekumpulan sel yang telah digabungkan menjadi satu dengan 

tujuan tertentu, misal untuk pemformatan beberapa sel secara bersamaan, 

mencari nilai rata-rata dari sekumpulan data dan lain-lain. Contoh range adalah 

B2:D4 yang berarti mulai dari kolom B baris ke-2 sampai dengan kolom D baris 

ke-4. Range juga dapat diberi nama sesuai dengan data yang ada di dalamnya 

yang bertujuan agar mempermudah saat pengolahan data sehingga kita tidak 

melakukan pengeblokan secara berulang-ulang. 

Langkah untuk memberi nama sebuah range adalah: 

 Blok data pada sel-sel yang akan didefinisikan sebagai nama range 

 Klik menu Insert 
 Pilih Name 

 Klik Define 

 Pada kotak dialog yang ada tuliskan nama range, 

 Kemudian klik tombol OK. 

 

 

 

          ATA DAN OPERASI DATA 

 
1.  Jenis Data dalam Microsoft Excel 
Secara garis besar Microsoft Excel membagi data yang diolah menjadi dua, 

yaitu:  

 

a. Data Karakter 
 Seluruh data yang dimulai dari pengetikan huruf (A s/d Z) 

 Karakter non angka yang berdiri dengan angka, misal B123 atau 50F2 dan 

seluruhnya tidak dapat dioperasikan secara aritmatik. 

Microsoft Excel 12



 

 

b. Data Numerik 
 Semua angka merupakan data numerik karena dapat diolah secara 

aritmatik. 

 Angka yang ditulis dalam bentuk Eksponensial, misal 2E6 artinya sama 

dengan 2000000. 

 Angka tanggal yang diketik dengan format MM/DD/YY. 

 Angka jam yang diketik dengan format HH:MM:SS. 

 
2.  Memasukkan Data 

Cara pemasukan data adalah dengan mengetik secara langsung ke dalam sel 

yang telah kita maksudkan. Pengisian data dapat kita lakukan secara manual atau 

dengan menggunakan autofill yang biasa digunakan untuk data yang berurutan 

seperti nomor urut, nama hari, nama bulan, tahun dan sebagainya. 

 

 
 

 

Data yang 
diketik 
manual 

Huruf B 
diperbanyak 
dengan Copy 

Angka 2 
diperbanyak 
dengan Copy 

Angka 1 dengan 
Autofill dapat m
urutan 

embuat 

Gambar 14. Cara-cara Pengisian Data 

 
 
3.  Operasi Fungsi 
Fungsi di dalam program spreadsheet adalah suatu fasilitas dalam hal 

perhitungan yang digunakan melakukan penghitungan financial, statistic, analisa 

logika, pengambilan keputusan manipulasi teks dan lain-lain.    
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Formula Bar 
Sebelum membahas fungsi-fungsi yang disediakan oleh Microsoft Excel, anda 

harus memahami formula bar sebagai salah satu kunci utama untuk 

menyelesaikan suatu rumus. 

 

 

 Edit Formula, untuk memulai 
pembuatan rumus atau fungsi 

Menampilkan rumus yang tengah dibuat atau 
rumus yang terdapat pada suatu sel  

 List Box 
Formula 

Untuk menampilkan List Box 
Formula/Daftar Fungsi 

 

 

 

 

 Cancel Enter 

 

Gambar 15. Formula Bar 

 
Fungsi Dasar 
Dalam fungsi dasar penekanan fungsi adalah terbatas pada perhitungan data 

aritmatika dengan menggunakan operator-operator: 

 

Operator Aritmatika Operator Relasional 
+ Penjumlahan = Sama Dengan 

_ Pengurangan > Lebih Besar 

* Perkalian < Lebih Kecil 

/ Pembagian >= Lebih Besar atau Sama Dengan 

^ Pangkat <= Lebih Kecil atau Sama Dengan 

 
Berikut adalah contoh langkah penggunaan Fungsi Dasar untuk mencari Nilai 
Keuntungan yang didapat dari Harga Jual dikurangi Harga Beli. 
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Gambar 15. Pembuatan Fungsi Dasar 

 
Fungsi Statistik 
1. Fungsi penjumlahan data  = SUM (Range) 
2. Fungsi pencarian nilai terbesar  = MAX (Range) 
3. Fungsi pencarian nilai terkecil  = MIN (Range) 
4. Fungsi pencarian nilai rata-rata  = Average (Range) 
5. Fungsi pencarian jumlah data angka = Count (Range) 
 

 

 

 

 

 

 

 

 

 

 

 

Gambar 16. Contoh Fungsi statistic 

2. Klik Edit Formula untuk 
memulai membuat rumus 
(ketik ‘=’ ) 

5. Drag ke bawah untuk 
memperbanyak rumus agar 
tidak perlu mengulang rumus 

3.   Klik pada sel yang Harga Jual  
C4 (’C4’ otomatis muncul) 
kemudian ketikkan operator 
Pengurangan (’-’) 

4. Klik sel Harga Beli (B4) 
kemudian Enter 

1. Klik pada sel yang 
akan diisi (D4) 



 

Sebagai contoh, perhatikan Gambar 16, jika diinginkan mencari Jumlah 

seluruh nilai dari murid tersebut, dan hasilnya ditaruh di sel D15, caranya adalah 

sebagai berikut. 

1. Tempatkan pointer mouse dan pilih sel aktif D15 (Perhatikan Gambar 16). 

 

 

 

 
 

Gambar  17. Tombol “Insert Function”. 
 

2. Klik tombol “Insert Function” (Gambar 17), maka segera akan muncul 

kotak dialog Insert Function seperti Gambar berikut. 

 
 

 

 

 

 

 

 

 

 

 

 

Gambar 18. Kotak dialog Insert Function 

 Dalam kotak dialog Insert Function ini, kita bisa mencari fungsi yang kita 

inginkan (dalam contoh kasus ini fungsi penjumlahan atau SUM). Dalam 

kotak Search for a function anda bisa mengetikkan diskripsi singkat (dalam 

bahasa Inggris) tentang apa yang ingin anda kerjakan lalu klik tombol Go. 

Maka jika fungsi yang dicari cocok atau ada maka akan segera tampil dan 

disorot di kotak daftar Select a function.  Dalam kasus ini coba anda 

ketikkan : add atau addition lalu klik tombol Go. Maka akan ketemu fungsi 

SUM yang telah disorot di kotak daftar Select a function.  
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3. Pilih fungsi SUM, lalu klik tombol OK. Akan tampil kotak dialog Function 
Arguments seperti gambar berikut. Kotak dialog Function Arguments 

digunakan untuk memasukkan nilai-nilai dari parameter atau argumen yang 

dibutuhkan oleh suatu fungsi tertentu. Blok kolom dalam tabel yang akan 

dicari jumlah totalnya. 

 

 

 

 

 

 

 

 

 

  

Gambar 19. Kotak dialog Function Arguments 

 

4. Klik Tombol OK. Maka hasil penjumlahan akan muncul di sel D15. 

 
Fungsi Logika 

Dalam Excel ada beberapa fungsi logika diantaranya adalah : AND, OR. FALSE, 
NOT, IF,  dan TRUE. Fungsi logika FALSE (TRUE) tidak memiliki argumen, fungsi 

ini digunakan untuk mendapatkan nilai logika false (true). Fungsi logika IF 

berfungsi untuk menguji suatu logika kondisi dengan syarat tertentu untuk 

mendapatkan nilai benar atau salah. Logika tunggal adalah pengujian dengan 

menggunakan satu syarat yang ditetapkan. Statemen fungsi logika IF adalah 

sebagai berikut:  

 
 =IF(Logical_test; Value_if_true; Value_if_false) 
 

 Logical_Test : Sel yang diuji dan syarat yang ditetapkan atau semua nilai 

atau expresi yang dapat dievaluasi ke nilai benar atau salah. 
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 Value_If_True : Kondisi yang akan dikembalikan jika syarat yang ditetapkan 

terpenuhi. 

 Value_If_False : Kondisi yang akan dikembalikan jika syarat yang ditetapkan 

tidak terpenuhi. 

Contoh :  

Gambar 20 adalah sebuah tabel dengan judul No.Nota, Kode dan Keterangan. 

Kolom keterangan diisi dengan keterangan yang berkaitan dengan kolom Kode.  

 Jika Kode adalah ‘S’, maka Keterangan “Simpati” 

 Jika Kode adalah ‘M’, maka Keterangan “Mentari” 

 

 
Gambar 20. Latihan fungsi logika tunggal 

Langkah-langkahnya adalah: 

1. Klik sel C4 

2. Klik tombol Insert Function (Gambar 17). 

3. Pilih fungsi logika: IF,  lalu klik OK. 

4. Dalam kotak dialog Function Argument dari fungsi IF ini, klik di kotak isian 

Logical_test. Klik sel B4, lalu ketikkan di kotak isian Logical_test tadi 

tambahan teks ‘=”S”’, hingga tampilan kotak isian Logical_test seperti 

Gambar 21 berikut. 

5. Kemudian di kotak isian Value_is_true ketikkan “SIMPATI” 

6. Di kotak isian Value_is_false ketikkan ”MENTARI”. 

7. Klik tombol OK, perhatikan isi dari sel C4.  

8. Duplikasi atau perbanyak formula yang ada di C4 ke baris-baris di 

bawahnya hingga C9.  
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Gambar 21. Fungsi logika tunggal 
 

Fungsi Logika Bertingkat 
Logika bertingkat terjadi jika syarat yang ditetapkan lebih dari satu. 
Contoh: 

 Jika Kode adalah ‘S’, maka Keterangan “Simpati” 
 Jika Kode adalah ‘M’, maka Keterangan “Mentari” 
 Jika Kode adalah ‘I’, maka Keterangan “IM3” 
 Jika Kode adalah ‘H’, maka Keterangan “Hallo” 

Maka statemen fungsi logika akan bertingkat mengikuti jumlah syarat dengan 
struktur sebagai berikut: 
 

=IF(Logical_test_1;Value_if_true_1;IF(Logical_test_2;Value_if_true_2; 
IF(Logical_test_3;Value_if_true_3;value_if_false))) 
 

 
Gambar 22. Fungsi Logika bertingkat 
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Langkah-langkahnya sebagai berikut. 
1. Klik sel C3, lalu klik tombol Insert Function. 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar  23. Logika bertingkat 

Logica test 1 

Pada Value if False 1, 
klik List Box Formula 
kemudian pilih IF lagi 

Value if true 1

Logika test 2 

Logika tes  3 t

Pada Value if False 2, 
klik List Box Formula 
kemudian pilih IF lagi 

Value if true 2

OK untuk mengakhiri

Value if false 3 yang 
berarti Logika test 1,2 
dan 3 tidak terpenuhi 

Value if true 3



 

Fungsi VLOOKUP 
Fungsi VLOOKUP dipergunakan untuk pengisian sel dengan membaca tabel 

referensi yang telah dibuat sebelumnya berdasarkan kode yang terdapat pada sel 

kunci. Statemen fungsi VLOOKUP adalah sebagai berikut: 

         =VLOOKUP(Lookup_value;Table_array;Col_index_num;Range_lookup) 
 Lookup_value 

Alamat sel kunci yang berfungsi sebagai kunci penghubung dengan tabel 

referensi. 

 Table_array 

Nama range tabel referensi yang sudah didefinisikan sebelumnya. 

 Col_index_number 
Angka index yang menunjukkan nomor kolom pada tabel referensi yang akan 

dibaca. 

 Range_lookup 
Suatu statemen logika TRUE dimana data akan dioleh dengan 
pendekatan/pembulatan pada sel kunci dan data kunci sehingga kebenaran 
tidak akurat, atau FALSE akan menyalahkan setiap sel kunci yang tidak sesuai 
dengan data kunci referensi. 

Contoh kasus: Perhatikan Gambar 24 berikut ini. Jika diinginkan untuk 

mengkonversi nilai angka dari kolom Bahasa Inggris ke dalam nilai huruf dengan 

ketentuan seperti tabel referensi maka langkah-langkahnya adalah sbb. 

 

 

tabel 
referensi 

  

 

 

 

 

 

 

 

 

 

Gambar 24. Fungsi VLOOKUP 
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Langkah-langkahnya: 
1. Buatlah atau definisikan nama tabel referensi dengan nama nilaihuruf. 

Caranya adalah: blok tabel referensi (G5:I9), klik menu Insert | Name | 
Define. Perhatikan Gambar berikut. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 25. 
 

Pada kotak dialog Define Name isikan pada kotak isian Names in workbook 
nama tabelnya yakni : nilaihuruf. Lalu klik OK. 
 
 
 

 
 
 
 
 
 
 

Jabatan (D4) 
 
 

Gambar 26. 
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2. Klik pada sel E5.  
3. Klik tombol Insert Function, hingga muncul kotak dialog insert function 
4. Cari fungsi VLOOKUP, klik OK, hingga muncul kotak dialog Function 

Argument dari VLOOKUP. Isilah seperti gambar berikut. Lalu klik OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 27.  Kotak dialog Function Arguments dari Vlookup 

 
5. Maka akan terisi di sel E5 dengan nilai B. 
6. Gandakan formula yang ada di E5 ke baris dibawahnya hingga E14, maka 

proses konversi nilai angka ke huruf sudah selesai. 
 

Fungsi Text 
Fungsi text digunakan utnuk membaca pada bagian tertentu dari suatu teks yang 

terdapat pada sebuah sel. Teks yang terbaca terbagi menjadi tiga bagian yaitu 

bagian kiri, tengah dan kanan. 

1. LEFT(Text;Num_chars) 
2. MID (Text;Start_num;Num_chars) 
3. RIGHT(Text;Num_chars) 
 

 Text  : Letak sel dari teks yang akan dibaca 

 Start_num : Nomor karakter pertama dari teks yang akan dibaca 
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 Num_chars : Jumlah karakter yang dibaca 

 

 

 
Gambar 28. Fungsi Text 

Ketentuan: 

Nomor siswa terbagi menjadi tiga bagian: 

 Dua karakter di sebelah kiri adalah Tahun Angkatan 

 Empat karakter di tengan adalah Nomor Induk 

 Satu karakter disebelah kanan adalah Jurusan 

 

Nomor induk (B5) 

 
Gambar 29. Fungsi MID 

 

Jurusan (C5) 

 Jika “L” maka “LISTRIK” 
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 Jika “M” maka “MESIN” 

 

 
Gambar 30. Fungsi RIGHT 

 

 

Tahun Angkatan (D5) 

 
Gambar 31. Fungsi LEFT 
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LAYOUT DATA 
Pengurutan Data 

Data yang dientry pada tabel dengan acak dapat diurutkan (SORTIR) berdasarkan 

kriteria tertentu dengan langkah-langkah sebagai berikut : 

 Blok data yang akan diurutkan (judul kolom dan nomor tidak diikutkan) 

 Klik menu DATA,kemudian klik SORT  

 Sort by untuk menentukan kriteria utama pengurutan 

 Then by untuk menentukan kriteria ke dua dan ke tiga (dapat 

diabaikan) 

 Ascending  : urutan menaik (A – Z atau 0 – 9) 

 Descending : Urutan menurun (Z – A atau 9 – 0)  

  Header row, baris pertama tidak diikutkan dalam pengurutan 

  No header row, baris pertama diikutkan dalam pengurutan 

 
 

 
Gambar 32. Mengurutkan data (SORTIR) 

 

Memformat Angka 
Agar data angka lebih mudah dibaca, Anda dapat memberikan format tertentu 

sesuai dengan dengan jenis angka yang akan di format. Jika menggunakan tabel 

Daftar Gaji di atas maka, blok data pada kolom Gaji Pokok kemudian klik menu 

FORMAT, pilih CELLS 
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  Klik tab NUMBER 
  Tentukan kategori : ACCOUNTING 

 Decimal Places untuk menentukan jumlah bilangan decimal 
 Symbol untuk menentukan Currency misal $ atau Rp kemudian klik 

OK 
 

 
Gambar 33. Format angka 

 

Membuat Tabel Excel 
Pembuatan tabel adalah langkah terakhir untuk mendapatkan layout yang 

menarik. Jika menggunakan contoh pada tabel Daftar Gaji di atas maka lakukan 

langkah-langkah sebagai berikut : 

  Blok lokasi pembuatan  tabel pada range B3 :E15 
  Klik menu FORMAT, kemudian pilih CELLS 

  Klik tab BORDER 
 Pilih bentuk garis yang disediakan pada Line Style 
 Tempatkan garis yang dipilih dengan tombol OUTLINE, 

INSIDE atau klik pada tombol-tombol BORDER kemudian 

akhiri dengan klik OK 
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 Pembuatan tabel tidak dapat diselesaikan dengan satu kali perintah, lakukan 

dengan cara yang hampir sama untuk membuat garis dibawah judul kolom  
 

 

 
Gambar 34. Membuat tabel 
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              RAFIK 

 
 

Selain laporan dalam bentuk tabel, Excel juga menyediakan fasilitas grafik dengan 

banyak pilihan untuk menyajikan suatu laporan atau data. Misalnya suatu tabel 

daftar nilai suatu kelas.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 35. Contoh tabel untuk pembuatan grafik 

 

Untuk pembuatan grafik ikuti langkah-langkah sebagai berikut : 

 Blok data yang akan dibuat grafik dengan ketentuan, kolom pertama adalah 

sumbu x, kolom ke dua sumbu Y(1), kolom ke tiga sumbu Y(2) dan seterusnya. 
Jika ingin membuat grafik dimana sumbu x adalah kolom Nama, dan sumbu y 

adalah kolom Bahasa Inggris, maka blok dahulu kolom Nama, lalu tekan Ctrl 

(jangan dilepas), lalu langsung blok kolom Bahasa Inggris (Gambar 32). 

 Klik icon Chart Wizzard  
 Akan ditampilkan tuntunan langkah pembuatan grafik yang terdiri dari 4 

langkah yaitu : 
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1. Memilih bentuk grafik yang akan dibuat 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 36. 

 

2. Menentukan jangkauan data (Data Range) dan nama series masing-

masing sumbu Y 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 37. 
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3. Mengisikan judul-judul grafik dan memperbagus tampilan grafik 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 38. 

4. Menentukan letak grafik yang sudah jadi. 
 
 

 

 

 

 

 

 

Gambar 39. 

Jika dipilih As new sheet maka grafik akan dibuat dalam worksheet baru, tapi 

jika dipilih As object in, maka grafik akan ditempatkan (ditempelkan) dalam 

worksheet yang aktif saat itu. 

       
Untuk membuat grafik Pie, maka pada langkah 1 (Step 1 of 4) Gambar 36 
di atas, dipilih model grafik Pie, langkah-langkah berikutnya hingga 
langkah terakhir tidak banyak perbedaan. 

Microsoft Excel 31



HANDOUT WORKSHOP INTERNET 
 
Definisi internet : 

- Internet adalah kumpulan jaringan komputer, baik besar maupun kecil, 
yang saling terhubung satu dengan yang lainnya diseluruh dunia 
dengan menggunakan jaringan komunikasi seperti telepon, gelombang 
radio, dan lain sebagainya. 

 
A. Browsing 

Browsing atau surfing adalah kegiatan menjelajahi dunia melalui internet 
untuk mencari informasi yang kita inginkan. Software yang digunakan 
disebut dengan WEB BROWSER. 
Ada banyak sekali jenis Web Browser, beberapa yang paling banyak 
digunakan antara lain Internet Explorer, Mozilla Firefox, Opera, dan 
Netscape. 
Dari keempat Web Browser diatas yang paling banyak digunakan adalah 
Microsoft Internet Explorer. Berikut adalah komponen-komponen utama 
dari Microsoft Internet Explorer : 

Komponen-komponen Utama Microsoft Internet Explorer 

4 

5 

1

2 

3 

Keterangan : 
1. Titlebar  : berisi judul dari situs dan nama Web Browser. 
2. Menubar : berisi menu-menu untuk pengolahan Web Browser 
3. Toolbar  : merupakan tombol yang mempersingkat pengaktifan  
    suatu perintah daripada jika menggunakan menu 
4. Web Page : untuk menampilkan halaman situs yang kita buka 
5. Status Bar : informasi mengenai status suatu proses 
 



Menubar 
Terdiri dari 5 menu , yaitu : 

 
 

1. Menu File 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Menu Item Keterangan 

New Membuka tampilan window baru 
Open Membuka halaman web baru 
Edit with Microsoft 
Office Word 

Mengedit (merubah) isi dari web yang terbuka 
dengan Microsoft Office Word 

Save Menyimpan halaman web 
Save As Menyimpan halaman web dengan pemberian 

nama file yang baru 
Page Setup Mengatur halaman web jika ingin mencetak 

(print) 
Print Mencetak halaman web yang terbuka 
Print Preview Melihat hasil cetakan sebelum dilakukan 

pencetakan 
Send Mengirim (menyimpan) alamat web yang 

terbuka 
Import and Export Mengambil atau mengirimkan informasi yang 

ada dalam Microsoft Internet Explorer seperti 
Favorite dan Cookies 

Properties Informasi dari halaman web yang terbuka 
Work Offline Mematikan koneksi internet 
Close Menutup aplikasi Microsoft Internet Explorer 

 
 
 
 
 
 
 
 
 



2. Menu Edit 
 
 
 
 
 
 
 
 

Menu Item Keterangan 
Cut Menghapus teks 
Copy Menyalin teks 
Paste Menempelkan teks 
Select All Memilih semua teks yang ada dalam halaman 

web yang terbuka 
Find (on This Page) Mencari suatu teks dalam halaman web yang 

terbuka 
 
3. Menu View 

 
 
 
 
 
 
 
 
 
 
 
 
 

Menu Item Keterangan 
Toolbars Mengaktifkan maupun menonaktifkan Toolbar 

yang ada 
Status Bar Mengaktifkan maupun menonaktifkan status dari 

perintah yang sedang dan akan dipilih 
Explorer Bar Menampilkan Toolbar Explorer yang ada 
Go to Perintah untuk menampilkan halaman web 

sebelum atau sesudah atau halaman utama dari 
web.  

Stop Menghentikan proses 
Refresh Mengulang proses 
Text Size Mengatur ukutan teks 
Encoding Memilih pengkodean 
Source Menampilkan kode program dari halaman web 
Privacy Report Informasi file-file yang digunakan dalam 

halaman web 
Full Screen Menampilkan halaman web secara Full Screen 



4. Menu Favorite 
 
 
 
 
 
 
 
 

Menu Item Keterangan 
Add to Favorite Halaman web yang terbuka dijadikan web yang 

disukai 
Organize Favorite Mengatur halaman web yang disukai 
Links Folder (Direktori) yang berisi halaman web yang 

disukai 
 
5. Menu Tools 

 
 
 
 
 
 
 
 
 
 

Menu Item Keterangan 
Mail and News Membaca dan mengirin email 
Pop-up Blocker Mengaktifkan atau menonaktifkan Pop-up 
Manage Add-ons Menngatur Add-ons 
Synchronize Mensikronkan data dalam komputer dengan 

data di jaringan 
Windows Update Memperbarui fitur-fitur windows 
Sun Java Console Membuka konsol java 
Internet Options Mengatur Web Browser 

 
6. Menu Help : merupakan menu untuk mencari informasi mengenai 
pemakaian Web Browser. 
 
Toolbar 
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Keterangan : 
1. Address : untuk menuliskan alamat suatu situs 
2. Go : menjalankan alamat situs yang telah ditulis 
3. Back : kembali ke halaman web sebelumnya 
4. Next : kembali ke halaman web selanjutnya 
5. Stop : menghentikan proses 
6. Refresh : mengulang proses 
7. Home : kembali ke halaman utama dari sebuah situs 
 
Berikut ini adalah contoh membuka sebuah situs (ketik alamat situsnya 
kemudian klik Go atau langsung tekan Enter pada Keyboard komputer 
setelah selesai mengetik alamat situs) : 
 

B. Email 
lectronic Mail – surat elektronik) adalah sarana yang digunakan 

apat mengirim email, sebelumnya kita harus mempunyai alamat 

 
 

Email (E
untuk mengirim dan menerima informasi melalui internet ke seluruh 
pengguna internet dalam waktu yang sangat cepat (hanya beberapa 
detik). 
Untuk d
email sendiri terlebih dahulu. Ada banyak sekali penyedia alamat email 
gratis, antara lain Yahoo, Gmail, dan Hotmail. 
Berikut adalah cara membuat email di Yahoo : 



1. Buka Internet Explorer dan ketik http://www.yahoo.co.id lalu tekan 
tombol Go pada Toolbat atau dapat langsung menekan tombol Enter 
pada Keyboard komputer sehingga muncul situs Yohoo seperti 
dibawah : 

 
2. Klik Masuk bila anda sudah mempunyai Account email di Yahoo. 

Apabila belum, klik Daftar untuk membuat Account baru. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.yahoo.co.id/


3. Kita juga dapat mengetik http://mail.yahoo.co.id untuk langsung masuk 
ke halaman Login email seperti gambar berikut. 

 

 
4. Apabila anda sudah mempunyai Account, anda bisa langsung Login 

(masuk ke halaman email anda) dengan mengetik data ID Yahoo! dan 
Sandi setelah itu klik tombol Masuk. 

 
5. Isi Form sesuai dengan data yang diminta dimana jika terdapat tanda * 

(bintang) maka data harus diisi, sedang jika tidak ada tanda * (bintang) 
maka data boleh diisi maupun tidak. 

 
6. Email di Yahoo menyediakan fasilitas jika kita lupa sandi (Password).  

 
 
 
 
 

http://mail.yahoo.co.id/


 

 
 
 



7. Jika data yang diminta sudah terisi, klik Saya Setuju. 
8. Jika ada terdapat kesalahan pengisian data maka akan ditampilkan 

halaman pemberitahuan. Berikut ini adalah halaman pemberitahuan 
untuk : 

a. data ID Yahoo karena identitas yang kita pilih sudah terpakai  
oleh orang lain. 

b. Sandi yang kita pilih mirip dengan nama kita. 
c. Kode registrasi tidak ditulis. 

 
9. Isi kembali data yang diminta untuk diperbaiki, ditandai dengan blok 

warna kuning. 



 
10. Klik Kirim Formulir ini secara Aman. 
11. Jika pendaftaran berhasil, maka akan muncul halaman berikut : 

 
 



12. Masuk ke halaman email anda. 

 
13. Untuk melihat email yang masuk, klik Kotak Masuk atau Cek Surat. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 



14. Untuk membaca surat yang masuk, arahkan Pointer Mouse pada 
bagian topik dari surat yang masuk (dalam hal ini topiknya tulisan 
Selamat datang di Yahoo!) dan klik. 

 
15. Untuk menghapus email, klik tombol Hapus. 
16. Untuk menjawab email, klik tombol Jawab. 
17. Untuk meneruskan email ke teman yang lain, klik Teruskan. 
18. Bila email merupakan Spam, klik tombol Spam. 
19. Klik Pindahkan apabila anda ingin memindahkan email ke direktori. 
20. Untuk mengirim email, klik Tulis. 

 
 

21. Tulis alamat email dari teman yang akan kita kirimi email pada bagian 
Kepada. Atau jika kita sudah menyimpan alamat email dari teman kita, 
anda dapat meng-klik Masukkan alamat. 



22. Anda bisa meng-klik Tambahkan CC atau Tambahkan BCC untuk 
membuat tembusan dari surat yang anda kirim. Kemudian ketik alamat 
email dari tembusannya. 

23. Tulis Topik surat yang anda kirimkan. 
24. Bila ingin mengirim suatu file, klik Lampirkan File. 

 
 
25. Klik tombol Browse untuk memilih file yang kita inginkan. 

 
 
 
 
 
 
 
 



26. Dengan menggunakan Mouse, sorot file yang kita pilih kemudian klik 
Open. Atau klik dua kali file yang kita pilih.  

 
 
27. Klik tombol Lampirkan File untuk memasukkan file dalam email kita. 

Tunggu sampai proses scaning selesai. 

 
 

28. Bila file yang akan kita kirim tidak mengandung virus, maka akan 
muncul halaman pemberitahuan sebagai berikut : 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



29. Klik tombol Lanjutkan ke Pesan untuk masuk ke halaman email lagi 
dan tulis pesan anda. 

 
 

30. Klik tombol Kirim untuk mengirim email. Bila pengiriman berhasil maka 
akan muncul pemberitahuan sebagai berikut : 

 
 

31. Bila alamat teman yang anda kirimi email belum tersimpan di buku 
alamat anda, klik tombol Tambahkan ke Buku Alamat. 

 
 

32. Isi data yang diminta, nama depan, nama belakang, dan nama 
panggilan kemudian klik tombol Tambahkan ke Buku Alamat. 

 



33. Bila kita ingin melihat email yang telah kita kirim, klik Terkirim pada 
halaman utama email kita. 

 
 

34. Klik tab Alamat untuk menambah data alamat email teman kita. 

 
 

35. Isi data yang diinginkan, setelah itu klik tombol Tambah untuk 
menyimpan data yang telah kita isi, maka Buku Alamat akan 
bertambah. 

 



36. Bila anda ingin keluar dari halaman email anda, lakukan Logout 
terlebih dahulu agar aman. Caranya adalah klik Keluar pada halaman 
email anda. 

 

 
 

37. Bila anda berhasil keluar, maka akan muncul halaman seperti berikut : 



C. Mesin Pencari 
Mesin pencari (Search Engine) adalah aplikasi yang digunakan untuk 
mencari suatu informasi di internet. Mesin pencari yang banyak dipakai 
antara lain Google, Yahoo, dan MSN. 
Berikut adalah tampilan dari Mesin Pencari tersebut : 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mesin Pencari Google 
 
 Berikut adalah cara mencari informasi dengan menggunakan Mesin 
Pencari Google : 

1. Buka Internet Explorer dan ketik http://www.google.co.id sehingga 
muncul halaman Google seperti dibawah ini dan ketik kata kunci 
(Keyword) dari informasi yang kita inginkan dan klik tombol Telusuri 
dengan Google. 

 

http://www.google.co.id/


2. Berikut adalah hasil pencariannya. Pencarian akan menghasilkan 
semua situs yang cocok dengan kata kunci yang kita ketikan baik dari 
dalam maupun luar negeri. 

 
3. Bagian-bagian dari halaman hasil pencarian. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

C 
A 

D 
B 

F 
E 

G 

H 

M 

I J K L 



 

A. Tabs 
Untuk memilih pencarian web, gambar saja, grup Google atau direktori 
Google. 

B. Masukan Pencarian 
Untuk mencari di Google, ketikkan saja beberapa kata kunci yang 
deskriptif. Tekan Enter atau klik pada tombol Pencari Google untuk 
mendapatkan daftar hasil yang relevan. 

C. Tombol Pencari Google 
Klik tombol ini untuk melakukan mencarian lainnya. Anda juga dapat 
melakukan pencarian dengan cara menekan tuts 'Enter' di papan kunci. 

D. Pencarian Khusus 
Mengacu ke sebuah halaman yang memungkinkan Anda untuk 
menentukan pilihan pencarian, termasuk jumlah hasil yang ditampilkan 
per halaman, bahasa antarmuka, dan apakah hasil pencarian mau 
disaring menggunakan ModeKeluarga atau tidak.  

E. Pilihan Penelusuran 
Penelusuran ke semua Web yang ada atau hanya yang di Indonesia 
saja. 

F. Papan Statistik 
Bagian ini menampilkan pencarian yang Anda lakukan dan menunjukkan 
banyaknya hasil pencarian serta lamanya waktu yang dibutuhkan untuk 
melakukan pencarian. 

G. Judul Halaman 
Hasil pencarian di baris pertama adalah judul situs. Terkadang, akan 
muncul URL saja bukannya judul, yang berarti kalau halaman situsnya 
tidak ada judul, atau Google tidak mendata seluruh isi halaman situs 
tersebut. Kita masih akan tahu situs yang sama karena kita telah 
mendata situs yang berhubungan dengan situs yang kita cari. Kita akan 
kembali ke halaman stus kalau teksnya sama dengan situs yang kita cari 
walaupun halaman situs itu belum didata.  

H. Teks di bawah judul 
Teks ini didapat dari halaman situs yang telah ditebalkan.Sebelum 
melihat hasilnya, teks ini dapat dilihat isinya sesuai dengan yang dicari di 
halaman situs  

I. Hasil URL 
Ini adalah halaman situs yang dicari. 

J. Besar/ukuran 
Angka ini adalah ukuran dari porsi text yang ditemukan pada halaman 
web. Tidak diperhitungkan untuk situs yang tidak kami index.  
 
 
 



K. Tembolok 
Meng-klik link salinan (cached) memungkinkan Anda untuk melihat isi 
halaman web yang diperoleh pada saat kami mengindeksnya. Jika 
karena beberapa alasan link ke situs tidak membawa anda ke versi 
halaman yang sekarang, Anda masih dapat melihat versi salinannya dan 
mungkin bisa menemukan informasi yang Anda cari di sana. Pada versi 
salinan, kata-kata yang Anda cari akan ditandai dengan warna terang. 

L. Halaman Mirip  
Jika anda memilih halaman link yang sama untuk hasil yang lain, Google 
secara otomatis akan memandu menuju halaman yang bersesuaian.  

M. Hasil yang ter"indent" (posisi paragraf lebih ke dalam) 
Ketika Google menemukan hasil yang berulang untuk web site yang 
sama, hasil yang paling sesuai akan ditempatkan pada urutan pertama, 
kemudian disusul dengan halaman berikutnya (pages yg sama tersebut) 
pada posisi indent.  

 
4. Jika yang diinginkan adalah situs dari dalam negeri maka Option 

Telusuri di web diganti dengan Telusuri halaman dari Indonesia 
kemudian klik tombol Telusuri. 

 
 
 
 
 

 



5. Bila kita ingin menelusuri informasi bukan dengan tombol Telusuri 
dengan Google tetapi dengan tombol Saya lagi Beruntung, maka 
Mesin Pencari Google secara otomatis akan menampilkan situs yang 
mempunyai ranking tertinggi yang sesuai dengan kata kunci. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 



6. Berikut adalah halaman Google dengan pilihan Gambar untuk mencari 
informasi gambar. 

 

 
 

7. Berikut adalah halaman Google dengan pilihan Grup untuk mencari 
informasi grup mailing list. 

 



8. Berikut adalah halaman Google dengan pilihan Direktori untuk mencari 
informasi berdasarkan kategori tertentu. 

 
9. Untuk menghasilkan pencarian yang lebih akurat, maka bisa dilakukan 

pencarian khusus. Caranya adalah dengan meng-klik Pencarian 
Khusus. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
10. Mencari file dengan format tertentu. 

 
11. Mencari file pada tanggal tertentu. 



 
12. Contoh pencarian informasi dengan Pencarian Khusus. 

 
 

13. Hasilnya pencariannya adalah sebagai berikut : 

 
 
 
 
 
 
 
 
 
 



 
14. Untuk mendapatkan apa yang bisa dilakukan dengan google ada 

baiknya kita mengenali sintak yang disediakan oleh google untuk 
membantu melakukan pencarian.  Secara default google mengunakan 
operand AND apabila kita melakukan pencarian dengan lebih dari satu 
kata. 

15. Untuk pencarian dalam bentuk frasa maka kita harus menggunakan 
tanda kutip yang melingkupi kata kunci yang kita masukkan.  

16. Sedangkan untuk memaksa google agar tetap memasukkan kata-kata 
umum (misal how, of, for, dll) dalam sistem pencariannya maka kita 
harus menggunakan tanda plus (+) di depan kata yang umum tersebut.  

17. Untuk menghasilkan pencarian yang tidak mengandung suatu kata 
tertentu, maka digunakan tanda minus (-) di depan kata tersebut. 

18. Sintak- sintak ini digunakan secara langsung dalam kolom pencarian 
dan penggunaannya dapat dikombinasikan.  Adapun sintak- sintak lain 
yang sangat membantu pula dalam pencarian adalah sebagai berikut: 

 
intitle: 
Menemukan halaman-halaman web yang di dalam title (judul) HTML-
nya mengandung kata kunci (keyword) yang kita masukkan.  Contoh 
intitle:search berarti akan menemukan halaman yang didalam judul 
HTML-nya mengandung kata ‘search’ 

 

 
 
 
 
 
 
 
 
 



 
 Hasil pencariannya : 

 
 

Untuk melihat situs hasil pencarian arahkan kursor Mouse pada judul 
situs dan klik. Berikut adalah halaman web dari situs yang dipilih :  

 
 
 
 



 
inurl: 
 Menemukan URL (host, nama path, nama file)yang memiliki kata kunci 
yang kita masukkan.  

 

 
 
 

filetype: 
 Menemukan tipe file tertentu 

 
File PDF 

 
 
 
 



site: 
Menemukan halaman pada situs tertentu. 

 
 

link: 
Menemukan halaman yang memiliki hiperteks link ke URL tertentu 

 
 
 
 
 
 
 
 



 Hasil pencariannya kalau dibuka adalah sebagai berikut : 
 

 
 
 
Beberapa sintak lain bisa lihat di 
http://www.googleguide.com/advanced_operators.html 
 

D. Kumpulan situs MIPA dan Bahasa Inggris 
Situs Fisika : 
http://www.fisikaasyik.com/home/index.php 
http://www.fisika-smu.com/ 
http://www.fisika-suherman.com/ 
http://groups.yahoo.com/group/pesonafisika/ 
http://www.ganeca-exact.com/dld/sainfisikasmp2a.swf 
http://www.dikmentidki.go.id/belajar/fisika.htm 
http://www.physicscentral.com/ 
http://www.physicsclassroom.com/ 
http://dir.yahoo.com/Science/physics/ 
http://physics.about.com/ 
http://www.physics.org/ 
 
 
 
 
 
 
 
 

http://www.googleguide.com/advanced_operators.html
http://www.fisikaasyik.com/home/index.php
http://www.fisika-smu.com/
http://www.fisika-suherman.com/
http://groups.yahoo.com/group/pesonafisika/
http://www.ganeca-exact.com/dld/sainfisikasmp2a.swf
http://www.dikmentidki.go.id/belajar/fisika.htm
http://www.physicscentral.com/
http://www.physicsclassroom.com/
http://dir.yahoo.com/Science/physics/
http://physics.about.com/
http://www.physics.org/


Situs Bahasa Inggris : 
http://www.edufind.com/ 
http://esl.about.com/ 
http://www.bbc.co.uk/worldservice/learningenglish/ 
http://www.englisch-hilfen.de/en/ 
http://www.pendidikan.net/english/ 
http://www.englishclub.com/ 
http://www.english-at-home.com/ 
http://www.britishcouncil.org/kids.htm 
http://www.dikmentidki.go.id/belajar/inggris.htm 
 
 
Situs Matematika : 
http://www.matkita.com/tampilan_depan.php 
http://directory.google.com/Top/Science/Math/Publications/Online_Texts/ 
http://www.ams.org/mathweb/mi-books.html 
http://www.math.gatech.edu/%7Ecain/textbooks/onlinebooks.html 
http://historical.library.cornell.edu/math/ 
http://www.cis.upenn.edu/%7Ewilf/ 
http://www.ams.org/online_bks/online-books-web.html 
http://planetmath.org/ 
http://www.mathpuzzle.com/ 
http://zaki.web.ugm.ac.id/web/mod.php?mod=publisher&op=viewarticle&ar
tid=187 
http://www.dikmentidki.go.id/belajar/matematika.htm 
 
 
Situs Biologi 
http://www.dikmentidki.go.id/belajar/biologi.htm 
http://www.bbo.or.id/index.php?par=3a&menu=biologi3smp&des=BIOLOG
I%20KELAS%20III%20SMP 
http://www.google.com/Top/Science/Biology/ 
http://dir.yahoo.com/Science/Biology/ 
http://biology.about.com/ 
http://www.biology.com/ 
http://users.rcn.com/jkimball.ma.ultranet/BiologyPages/ 
http://www.biology4kids.com/ 
http://www.biology-online.org/ 
http://www.biologybrowser.org/ 
http://www.kidsbiology.com/ 
 
 
Bahasa Inggris, Fisika, Matematika, Biologi, dll 
http://www.oke.or.id/  
http://www.bbo.or.id/ 
 
 

http://www.edufind.com/
http://esl.about.com/
http://www.bbc.co.uk/worldservice/learningenglish/
http://www.englisch-hilfen.de/en/
http://www.pendidikan.net/english/
http://www.englishclub.com/
http://www.english-at-home.com/
http://www.britishcouncil.org/kids.htm
http://www.dikmentidki.go.id/belajar/inggris.htm
http://www.matkita.com/tampilan_depan.php
http://directory.google.com/Top/Science/Math/Publications/Online_Texts/
http://www.ams.org/mathweb/mi-books.html
http://www.math.gatech.edu/%7Ecain/textbooks/onlinebooks.html
http://historical.library.cornell.edu/math/
http://www.cis.upenn.edu/%7Ewilf/
http://www.ams.org/online_bks/online-books-web.html
http://planetmath.org/
http://www.mathpuzzle.com/
http://zaki.web.ugm.ac.id/web/mod.php?mod=publisher&op=viewarticle&artid=187
http://zaki.web.ugm.ac.id/web/mod.php?mod=publisher&op=viewarticle&artid=187
http://www.dikmentidki.go.id/belajar/matematika.htm
http://www.dikmentidki.go.id/belajar/biologi.htm
http://www.bbo.or.id/index.php?par=3a&menu=biologi3smp&des=BIOLOGI%20KELAS%20III%20SMP
http://www.bbo.or.id/index.php?par=3a&menu=biologi3smp&des=BIOLOGI%20KELAS%20III%20SMP
http://www.google.com/Top/Science/Biology/
http://dir.yahoo.com/Science/Biology/
http://biology.about.com/
http://www.biology.com/
http://users.rcn.com/jkimball.ma.ultranet/BiologyPages/
http://www.biology4kids.com/
http://www.biology-online.org/
http://www.biologybrowser.org/
http://www.kidsbiology.com/
http://www.oke.or.id/
http://www.bbo.or.id/


Desain Visual Pada Presentasi 
 
 
 
Peran Desain Visual dalam Komunikasi 

Komunikasi dalam proses PBM, guru tetap menjadi faktor utama, dan media 
tetap menjadi suatu alat.  Tetapi media yang kurang baik, akan mengganggu proses 
komunikasi yang mengakibatkan informamsi tidak dapat terserap dengan baik pada 
mahasiswa.  Menurut studi yang dilakukan oleh Bruner dalam Lester (2006) 
menunjukkan bahwa manusia hanya mengingat 10 persen apa yang dia dengar dan 30 
persen apa yang dia baca tetapi sekitar 80 persen apa yang dia lihat dan kerjakan.   

Dalam desain visual, warna menjadi faktor yang penting, menurut Ronald dalam 
situs 3M (www.3m.com), warna memiliki peran penting, yaitu dapat: 

• meningkatkan kesediaan untuk membaca sampai 80 persen. 
• meningkatkan motivasi dan partisipasi sampai 80 persen.  
• mempertinggi dan memperbaiki ingatan sampai 75 persen. 

Padahal dalam pengamatan di lapangan (ada dalam catatan, tetapi tidak ditampilkan 
dalam ulisan ini), kesalahan pemilihan warna merupakan faktor yang sering sering 
terjadi dalam banyak penyaji (Priyanto, 2007). 

Perlu diingat bahwa presentasi multimedia tidak sekedar menampilkan ”teks di 
layar” atau memindahkan teks dari buku ke layar.  Presentasi multimedia juga bukan 
menunjukkan kemampuan teknis menggunakan perangkat lunak presentasi (Power 
Point), tetapi lebih dari itu yaitu menekankan pada aspek desain visual (Kops, 2000).   

Dari studi dan pendapat tersebut, jelas bahwa desain visual yang baik dalam 
suatu presentasi memberi sumbangan yang besar dalam PBM berkaitan dengan 
penyerapan informasi.  

 
Konsep Desain Visual 

Guru atau siapa saja yang memerlukan media untuk presentasi, pasti akan 
berhadapan dengan tiga rangkaian keputusan bagaimana mengatur elemen-elemen  
visual.   Smaldino (2005) membagi rangkaian tersebut menjadi 3 golongan yaitu:  
• Elemen desain visual: meliputi elemen visual dan elemen verbal.  Elemen visual 

mencakup pemilihan gambar yang sesuai, elemen verbal meliputi pemilihan jenis 
dan ukuran huruf, spasisasi, kapitalisasi, dan pengaturan jumlah kata 

• Pola desain pesan: penyusunan pesan dalam satu tampilan slide yang meliputi 
kaidah pengaturan pesan, kesederhanaan, pengaturan tata letak, kesimbangan, 
pemilihan warna, dan pemilihan animasi dan suara 

• Penataan tampilan: meliputi konsistensi rangkaian slide dan elemen penambah 
daya tarik. 

Untuk menyederhanakan pembahasan, uraian desain visual di atas akan 
dituangkan dalam bentuk tips yang bisa langsung dipahami dan langsung dipraktikkan 
untuk menyusun presentasi. 
 
Bererapa Stetemen untuk pedoman penyusunan presentasi 

• PowerPoint more visual than written.  
• A picture is worth athousand words (Lester, 2006) 
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• Power Point Ranger (Pengelana Power Point) , adalah istilah militer untuk 
menyebut seorang yang lebih mahir membuat slide dari pada mengembangkan isi 
presentasinya. Jangan biarkan diri anda terjebak dalam perangkap (fitur) Power 
Point (Kops, 2002). 

• Delapan persen dari seluruh pria dan kurang dari satu persen wanita adalah buta 
warna.  Sebagian besar buta warna, sulit membedakan antara merah dan hijau, 
sehingga warna huru merah dengan latar belakang hijau, menjadi sulit dibedakan 
(Smaldino, 2005).  Sudahkan kita mempertimbangkan murid yang buta warna 
dalam menyusun presentasi? 

• Warna di layar komputer tidak selalu sama dengan yang ditampilkan LCD 
projector, hal ini disebabkan perbedaan resolusi, resolusi LCD projector lebih 
rendah dari layar monitor.  

 
Tips Membuat Presentasi Menggunakan Power Point 
 
A.  Tips Elemen Visual dan Verbal 

1. Pilih elemen visual yang tepat. Tipe visual dapat berupa visual nyata (foto), visual 
analogi, dan visual organisasi.  Pemilihan ini tergantung dari materi yang akan 
diberikan dalam pembelajaran.  Sebagai contoh untuk menunjukkan benda mobil, 
akan lebih baik bila menggunakan visual nyata.  Apabila akan menjelaskan 
tentang fungsi saklar yang menyalakan lampu, maka visual nyata tidak akan 
mendukung, yang tepat adalah menggunakan visual analogi.  Begitu pula untuk 
menunjukkan diagram suatu organsasi atau alur kerja, akan lebih tepat bila 
menggunakan visual organisasi. 

2. Pilih jenis dan ukuran huruf yang tepat 
• Font yang paling tepat untuk presentasi adalah keluarga Sans Serif (arrial, 

arrial black, futura, tahoma, dll) keluarga Serif (times new roman, courier) 
hanya cocok untuk versi cetak 

• Hindari penggunaan huruf kapital, gunakan hanya untuk penekanan 
• Minimalkan lettering style (bold, italics, underline, perubahan ukuran), 

maksimum 4 macam.  
• Ukuran huruf.  Aturan ukuran huruf berpedoman pada tinggi huruf lower case 

0,5 inch setiap 10 feet jarak pemirsa, setiap penambahan 10 feet jarak 
pandang, ukuran huruf ditambah 0,5 inch. Contoh: untuk jarak 60 feet, tinggi 
huruf 3 inch. 

3. Pilih Warna huruf dan latar belakang yang tepat 
• Untuk menjaga keterbacaan, warna huruf harus kontras dengan latar belakang, 

huruf gelap pada latar belakang terang atau sebaliknya, lihat tabel 1. 
• Penggunaan warna huruf tidak lebih dari 3 macam 
 

Tabel 1.  Penggunaan Warna yang efektif 

Background Foreground Images and Text Highlights 
white dark blue red, orange 

light gray blue, green, black red 
blue light yellow, white yellow, red 

light blue dark blue, dark green red-orange 
light yellow violet, brown red 
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4. Jumlah kata dan penomoran 
• Jumlah kata setiap slide tidak lebih dari 45 kata 
• Untuk penomoran lebih baik menggunakan bullet, bukan angka.   
• Jumlah bullet setiap halaman maksimum 6. 

 
B.  Tips Pola Desain Pesan  

Penentuan pola berfungsi menentukan bagaimana aliran mata siswa dalam 
melihat tampilan.  Pola desain pesan akan ditentukan oleh beberapa faktor yaitu: 
pesan tunggal per halaman (unity), kesederhanaan, pengaturan tata letak, 
kesimbangan, dan warna.  Kriteria penilaian untuk desain pesan menurut Smaldino 
(2005), Anthony (1995), dan Davidson (2006) adalah sebagai berikut: 
 

1. Setiap halaman hanya terdiri dari satu konsep atau ide.  
 

Dua Konsep Satu Konsep 
Slide 1 Slide 1 Slide 2 

GENERAL RULES: 

No Smoking, drinking, eating 
or shouting in the classroom. 

Use worksheet book, check 
your spelling and make sure 
homework is turned in on 
time. 

Page 1. 

CLASSROOM 
RULES: 

• No Smoking 
• No Drinking 
• No Eating 
• No Shouting 

Page 2. 

HOMEWORK: 

• No late 
homework  

• Use worksheet 
book 

• Check spelling 
 

 
Gambar 1.  Satu slide satu konsep 

 
2. Kesederhanaan, diwujudkan dengan pengaturan teks dan gambar yang tidak rumit 

serta tetap menjaga ruang kosong. 
3. Pengaturan tata letak harus mengacu pada bentuk geometris yang sederhana 

(lingkaran, segi empat, dan segi tiga). Selain itu memperhatikan kaidah rule of 
third, yaitu membagi layar menjadi tiga bagian secara vertikal dan horisontal, titik 
potong antara garis vertikal dan horisontal adalah posisi yang paling tepat untuk 
meletakkan gambar. 

4. Keseimbangan, adalah distribusi elemen visual (teks dan gambar) dalam satu 
halaman.  Keseimbangan akan dapat dicapai kektika ”bobot” elemen-elemen 
dalam tampilan terdistribusi secara seimbang pada masing-masing sisi poros 
horisontal dan vertikal.  Keseimbangan terdiri dari dua pilihan, yaitu formal 
balance dan informal balance. 

5. Menghindari animasi dan suara yang berlebihan.  Animasi digunakan untuk 
menjelaskan konsep yang susah dijelaskan dengan kata-kata. Animasi teks tidak 
akan memberi manfaat, pabila berlebihan justru akan mengganggu penyampaian 
pesan. 

6. Hindari penggunaan gambar yang tidak relevan, karena dapat mengacaukan pesan 
yang sebenarnya 
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C.  Tips Pengaturan Tampilan dan Daya Tarik  

Pengaturan tampilan dan daya tarik tidak melihat setiap halaman, tetapi melihat 
organisasi rangkaian slide dalam suatu presentasi. Pengaturan juga dilakukan pada 
rangkaian tampilan dari satu tampilan ke tampilan berikutnya, yang disebut 
konsistensi. Cara ini digunakan untuk menjaga konsistensi penyampaian pesan dan 
menghindari kebosanan.  Kriteria pokok untuk pengaturan tampilan menurut 
Smaldino (2005) dan Anthony (1995) adalah sebagai berikut: 
1. Konsistensi rangkaian halaman diwujudkan dengan menggunakan template yang 

sama untuk seluruh halaman.  Konsistensi template mencakup:  
• penggunaan warna latar belakang, letak judul dan warna, tata letak naskah dan 

gambar.     
• Penggunaan template antar tampilan harus sama, konsistensi template ini 

untuk menjaga aliran penyampaian informasi antara satu layar dengan layar 
berikutnya.  

 

 
Gambar 2 . Konsistensi template dan tata letak 

 
 

 
 

Gambar 3. Template dan tata letak yang tidak konsisten 
 

2. Elemen untuk menambah daya tarik terdiri dari tiga komponen yaitu: kejutan, 
tekstur, dan interaksi.   
• Kejutan berfungsi untuk menyedot perhatian dan menghindari kebosanan 

(menghilangkan urutan tampilan yang monoton), hal ini bisa dilakukan dengan 
kombinasi teks dan gambar yang tidak lazim, perubahan ukuran yang 
dramatis, dan pengggunaan warna yang tak diduga.  

Desain Visual pada Presentasi                                                                                                 4 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 4. Selingan untuk memutus konsistensi 
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Penggunaan Power Point Dasar 
 
 
Pendahuluan 

Sebagai guru hampir setiap saat dihadapkan dengan presentasi, khususnya 
diwaktu mengajar. Kebanyakan dari kita yang berpresentasi menggunakan aplikasi 
slide seperti Microsoft Power Point atau Open Office Presentation. Tentunya, 
kesederhanaan aplikasi slide ini memberikan batasan untuk bisa menampilkan 
presentasi visual yang menarik. Oleh karena itu, kadang aplikasi multimedia seperti 
Macromedia Flash bisa banyak membantu.  
Presentasi pada proses pembelajaran, seperti layaknya sebuah cerita, presentasi 
multimedia pun perlu diawali dengan intro yang menarik dan sesuai dengan tema 
materi yang disampaikan. 

Penggunaan musik dan efek suara juga sangat membantu membangun 
suasana presentasi. Kalau awalnya saja tidak menarik, mana mungkin para siswa 
(penonton) tertarik untuk melihat atau mengikuti materi presentasi tersebut lebih 
lanjut.  

Selanjutnya, pembagian konten presentasi. Penahapan yang tepat dan urutan 
presentasi perlu diperhatikan. Visual, musik, dan efek suara yang relevan dengan 
materi presentasi akan menjaga siswa (penonton) untuk terus tertarik 
memperhatikan. Bila materi yang disampaikan penuh dengan teks, atur jeda dengan 
menyisipkan ilustrasi, foto, video, atau aplikasi lain, di antaranya. Tujuannya, untuk 
meringankan beban mata penonton yang cenderung lelah bila dihadapkan teks terus 
menerus.  

Akhiri presentasi dengan kesimpulan yang mengarahkan ke siswa (penonton) 
akan materi atau pesan yang ingin disampaikan. Bila perlu, lengkapi dengan video 
atau animasi penutup yang memvisualkan berbagai kemungkinan implementasi 
materi yang disampaikan tersebut. 

 
Microsoft Power Point 

Microsoft Power Point merupakan salah satu aplikasi milik Microsoft, disamping 
Microsoft Word dan Microsoft Excel. Ketiga aplikasi ini biasa disebut Microsoft Office. 
Pada dasarnya, aplikasi Microsoft Power Point berfungsi untuk membantu user 
dalam menyajikan presentasi. Aplikasi ini menyediakan fasilitas Slide untuk dapat 
menampung pokok-pokok pembicaraan point-point yang akan disampaikan pada 
Audience. 

Dengan fasilitas, Animation, suatu slide dapat dimodifikasi dengan menarik. 
Begitu juga dengan adanya fasilitas: Font, Picture, Sound dan Effect dapat dipakai 
untuk membuat suatu slide yang bagus. Bila keadaan ini dapat disajikan, maka para 
pendengar dapat kita tarik perhatiannya untuk menerima apa yang ingin kita 
sampaikan kepada mereka. 

Setiap lembar tayangan berisi materi disebut Slide. Agar slide yang sedang 
dibangun dapat menarik, tujuan kita dalam menyampaikan suatu topik dapat 
tercapai, dan dapat dimengerti oleh audience dengan efektif, sebaiknya buat terlebih 
dahulu point bahasan yang perlu dicantumkan pada slide secara garis besar, dan 
diikuti sub point dari masing-masing point yang ada dan lengkapi dengan gambar, 
karikatur pada slide yang dimaksud. Berilah bullet, font, dan color yang menyolok 
pada point yang paling utama agar menjadi pusat perhatian. 

Diktat ini memberikan informasi dasar cara menggunakan Power Point 2003 
dan menggabungkan Power Point dengan aplikasi Windows lainnya. 

 
 



Komponen PowerPoint 

Toolbar 

 
 
 
    

Menubar 

Sebelum mulai bekerja dengan PowerPoint sebaiknya kita mengenal terlebih dahulu 
komponen-komponen jendela aplikasi PowerPoint 2003 
 Title bar  
 
 
 
 
 

Status bar 

Placeholder 

Outline tab 

Slide tab 
 

Dialog box  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Keterangan : 
Title bar tempat nama program dan nama file presentasi 
Menu Bar tempat menu disebut juga dengan Pull Down Menu. Bila kita 

mengklik salah satu menu maka akan terbuka sekelompok menu 
lain yang berhubungan dengannya 

Toolbar seperangkat icon yang berfungsi untuk menggantikan perintah-
perintah yang terdapat pada menu Bar, seperti Standart toolbar, 
Formatting toolbar, Drawing toolbar, dan sebagainya 

Outline tab untuk melihat presentasi dalam format outline 
Slide tab untuk melihat presentasi dalam format slide 
Dialog box kotak yang muncul pada layar bila kita mengaktifkan salah satu 

menu 
Slide pane tempat mendisain atau membuat slide 
Placeholder box untuk meletakkan aneka objek presentasi dan jenis objek dapat 

diatur dari berbagai pilihan yang tersedia di dalamnya 
Task pane tempat task dari power point yang dipilih. Jenis task dapat diubah 

sesuai dengan pilihan yang diinginkan 
Scrool Box vertikal sisi kanan layar dan horizontal di sisi bawah layar. 

Tempat menggeser tampilan slide pada bagian berikutnya jika 
slide tidak tertampil penuh. Jika slide tertampil penuh scroll box 
tidak ditampilkan 

Notes pane tempat menuliskan catatan atau keterangan slide 
Status Bar tempat menampilkan indikator status dari slide, yaitu nomor slide 

yang ditampilkan saat itu dari jumlah slide yang ada, nama disain 
slide yang digunakan, dan bahasa ejaan yang dipakai beserta 
pengecekannya 



Keterangan simbol gambar yang digunakan : 
 

 

Drag and Drop 
Letakkan pointer pada awal objek tekan tombol mouse kiri 
dengan tetap ditahan gerakkan pointer ke akhir objek lalu lepas 
tombol mouse kiri dari penekanan 

 

Click (Klik) 
Tekan tombol mouse kiri kemudian dilepas kembali 

 

Double Click (Klik dua kali) 
Tekan tombol mouse kiri kemudian dilepas kembali sebanyak 
dua kali berturutan 

 

See next page 
Pengerjaan pada halaman berikutnya  

 

End Task 
Pengerjaan tugas selesai 

 

Right-Click 
Tekan tombol mouse kanan kemudian dilepas kembali 

 

Pointer Arrow 
Penunjuk bagian yang dimaksudkan yang ditandai dengan 
menyalaterang di bagian tersebut 

 
Selection 
Daerah pada layar yang sedang dalam langkah kerja atau pengerjaan 

 

Type 
Klik sekali pada keyboard untuk memulai pengetikan tek atau data 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Kerja Dengan Menu dan Toolbar 
Cara kerja dengan memakai menu pada Power Point dapat dilakukan dengan 
langkah-langkah seperti berikut : 

 

 
To view the contents of a menu, click the menu name. The menu drops 
down from the menu bar to reveal a list of commands. 
Untuk melihat isi menu, klik nama menu. Menu akan membuka ke 
bawah dari batang menu untuk memperlihatkan daftar perintahnya. 

 
To execute a command, click the command name. 
Untuk menjalankan sebuah perintah, klik nama perintahnya. 

 
PowerPoint carries out the command, which may sometimes involve 
you selecting additional options from a dialog box. 
PowerPoint menjalankan perintah, yang kadang bisa melibatkan Anda 
agar memilih opsi-opsi tambahan dari kotak dialog. 

 
Some commands reveal an additional submenu of commands. Move 
the mouse pointer over the command to view a submenu. 
Beberapa perintah memperlihatkan submenu perintah tambahan. 
Gerakkan penunjuk mouse ke perintah itu untuk melihat submenu. 

 
 
 
 
 
 



Sedangkan cara kerja dengan memakai toolbar pada Power Point dapat dilakukan 
dengan langkah-langkah seperti berikut : 

 

 
To execute a toolbar command, click the command's toolbar button. 
Untuk menjalankan perintah toolbar, klik tombol toolbar perintah itu. 

 
PowerPoint carries out the command, which may involve you selecting 
additional options from a dialog box. 
PowerPoint menjalankan perintah itu, yang mungkin mengharuskan kita 
untuk memilih opsi-opsi tambahan dari kotak dialog. 

 
To view additional toolbar buttons, click the Toolbar Options button. 
Untuk melihat tombol toolbar tambahan, klik tombol Toolbar Options. 

 
A pop-up menu of additional buttons appears. Click a button to execute 
the command. 
Menu pop-up dari tombol tambahan akan muncul. Klik sebuah tombol 
untuk menjalankan perintah. 

 
 
 
 
 
 
 
 
 
 
 
 



PENGGUNAAN MENU 
Pada kondisi Default, Menu Bar Power Point terdiri dari sembilan kelompok menu. 
Mulai dari File di ujung kiri sampai Help di ujung kanan. Untuk mengakses perintah 
pada salah satu menu, Anda cukup mengklik nama perintah yang diinginkan. Pada 
layar akan muncul kotak dialog yang berhubungan dengan perintah tersebut 

 
Apabila kita klik menu title akan muncul Menu Item 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Menu File : Berisi daftar perintah yang digunakan untuk pengolahan file slide yang 
sedang (atau akan) dikerjakan. Daftar item menu file adalah : 
 

Menu Item Keterangan 

New Membuat presentasi baru 

Open Membuka presentasi 

Close Menutup presentasi yang telah dibuka 

Save Menyimpan presentasi yang telah dibuat 

Save As Menyimpan presentasi dengan nama lain 

Save As Web Page Menyimpan presentasi sebagai halaman Web 

File Search Mencari file presentasi PowerPoint 

Permission Menentukan izin akses file presentasi 

Package for CD Mengaktivkan fasilitas Package for CD 

Wabe Page Preview Preview presentasi sebagai halaman Web 

Menu Item 

Menu title 



Menu Item Keterangan 

Page Setup Menentukan setting slide 

Print Oreview Preview slide apabila akan dicetak 

Print Mencetak slide 

Send To Mengirim presentasi ke aplikaso lain 

Properties Properti file presentasi 

[Daftar File] Daftar empat file terakhir yang pernah dibuka 

Exit Keluar dari PowerPoint 

 

 

Menu Edit : Digunakan untuk memprose penyuntingan sebuah slide. Daftar item dari 
menu edit adalah: 

Menu Item Keterangan 

Undo Membatalkan kegiatan terakhir 

Repeat Mengulang kegiatan terakhir 

Cut Memotong suatu bagian slide dan menyimpannya dalam clipboard 

Copy Menyalin suatu bagian slide dan menyimpannya dalam clipboard 

Office Clipboard Clipboard khusus untuk aplikai Office yang mampu menyimpan 24 
item 

Paste Menyalin isi clipboard ke dalam slide 

Paste Spesial Paste dengan pilihan tertntu 

Paste As Hyperlink Paste dengan Hyperlink 

Clear Menghapus isi slide 

Select All Memilih seluruh isi slide 



Menu Item Keterangan 

Duplicate Menduplikasi seluruh isi slide 

Delete Slide Menghapus sebuah slide 

Find Mencari suatu teks dalam sebuah slide 

Replace Mencari sekaligus mengganti suatu teks dalam sebuah presentasi 

Go to Property Menuju ke properti objek tertentu 

Links Menyunting kaitan (links) yang ada dalam presentasi 

Object Menyunting objek-objek tertentu yang ada dalam presentasi 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Menu View : Digunakan untuk menentukan mode tampilan dari lingkungan kerja 
PowerPoint. Bisa juga digunakan untuk menampilkan atau menyembunyikan 
beberapa perangkat kerja PowerPoint. Daftar item dari menu view adalah : 

Menu Item Keterangan 

Normal Mode tampilan format 

Slide Sorter Mode tampilan slide sorter 

Slide Show Mode tampilan slide show 

Note Page Mode tampilan note page 

Master Mode tampilan master 

Color/Grayscale Menentukan mode warna presentasi 

Task Pane Menampilkan/menyembunyikan task pane 

Toolbar Memilih toolbar yang akan ditampilkan 



Menu Item Keterangan 

Ruler Menampilkan/menyembunyikan ruler 

Grid and Guides Menentukan alat bantu desain 

Header and Footer Menentukan header dan footer setiap slide 

Markup Menampilkan/menyembunyikan karakter markup yang ada pada slide

Zoom Memperbesar/memperkecil tampilan slide 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Menu Insert : Digunakan untuk menyisipkan objek atau fitur tertentu ke dalam slide. 
Daftar item dari menu insert adalah : 

Menu Item Keterangan 

New Slide Menyisipkan slide baru 

Duplicate Slide Menyisipkan slide baru dengan menduplikasi slide aktif 

Slide Number Menyisipkan nomor slide 

Date and Time Menyisipkan tanggal dan waktu 

Symbol Menyisipkan karakter-karakter khusus/simbolik 

Comment Menisipkan komentar 

Slide from Files Menyisipkan slide dari file presentasi lain 

Slide from Outline Menyisipkan slide dari sebuah outline 

Picture Menyisipkan gambar 

Diagram Minyisipkan diagram 



Menu Item Keterangan 

Text Box Minyisipkan kotak teks 

Movies and Sound Minyisipkan audio dan video ke dalam presentasi 

Chart Minyisipkan chart/grafik ke dalam slide 

Table Minyisipkan tabel ke dalam slide 

Object Minyisipkan objek-objek khusus ke dalam slide 

Hyperlink Minyisipkan hyperlink ke dalam slide 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Menu Format : Digunakan untuk mengatur format atau layout dari slide/presentasi 
yang sedang dikerjakan. Daftar item dari menu format adalah : 

Menu Item Keterangan 

Font Menentukan jenis huruf 

Bullet and Numbering Membuat daftar dengan bullet atau dengan angka 

Alignment Menentukan perataan teks atau gambar yg ada dlm slide 

Line Spacing Menentukan jarak spasi antarbaris 

Change Case Mengubah susunan huruf besar kecil pada sebuah kalimat 

Raplace Fonts Mengganti suatu jenis font dengan font yang lain 

Slide Design Menentukan desain slide 

Slide Layout Menentukan tata letak (layout) slide 

Background Menentukan latar belakang objek-objek pada slide 

Object Menentukan format objek yg disisipkan ke dalam slide 



 
Menu Tools : Berisi perangkat-perangkat bantu, baik yang berhubungan dengan 
pengolahan slide maupun menata lingkungan kerja PowerPoint.  Daftar item dari 
menu tools adalah : 

 
Menu Item Keterangan 

Spelling Mengaktifkan fitur pemeriksa ejaan 

Research Mengaktifkan fitur pencarian melalui internet 

Theausurus Mengaktifkan alat bantu yang berhubungan dengan kosakata 

Language Menentukan bahasa yang digunakan dalam presentasi 

Share Workspace Mengaktifkan fitur Share Workspace 

Compare and Merge 
Presentation 

Membandingkan file presentasi 

Online Collaborations Bekerjasama secara onlaine 

Macro Membuat macro 

Add-Ins Manajemen add-ins 

AutoCorrect Options Fitur koreksi otomatis 

Customize Manajemen toolbar dan perintah-perintah tertentu 

Option Manajemen lingkungan kerja PowerPoint 

 
 



 
Menu Slide Show : Digunakan untuk mengatur mode tampilan slide show.  Daftar item dari 
menu slide show adalah : 
 

Menu Item Keterangan 

View Show Mengaktifkan mode slide show 

Set Up Show Pengaturan setting mode slide show 

Rehearse Timings Memperkirakan atau mengatur waktu yang dibutuhkan untuk 
presentasi 

Record Narration Merekam narasi untuk sebuah presentasi 

Action Button Menyisipkan tombol aksi ke dalam slide 

Action Setting Menentukan aksi yang dipicu tindakan tertentu terhadap slide 

Animation Schemes Menentukan animasi yang akan diberikan terhadap bagian tertentu 
dari slide 

Custom Animation Menentukan bentuk animasi sendiri 

Slide Transition Menentukan bentuk transisi antar slide 

Hide Slide Menyembunyikan slide 

Custom Show Menentukan urutan tampilan slide 

 
 
 
 



Menu Window : Digunakan untuk mengatur jendela kerja PowerPoint.  Daftar item 
dari menu window adalah : 
 
dari menu window adalah : 
 

Menu Item Menu Item Keterangan Keterangan 

New window Membuka slide pada jendela baru 

Arrange All Menata semua jendela agar dapat ditampilkan pada layar 

Cascade Menampilkan slide dalam bentuk cascade 

Next Oane Menuju ke panel berikutnya 

[Daftar Presentasi] Daftar dari presentasi yang terbuka 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 
 
 
 
Menu Help : berisi fasilitas bantuan dari aplikasi PowerPoint termasuk Office 
Assistant.  Daftar item dari menu help adalah : 
 

Menu Item Keterangan 

Microsoft Office Fasilitas bantuan untuk aplikasi PowerPoint 
PowerPoint Help 

Show/Hide the Office 
Assistant 

Menampilkan atau menyembunyikan karakter Office Assistant 

Microsoft Office 
Online 

Membuka koneksi ke Internet menuju ke Microsoft Office Online 

Contact Us Informasi untuk menghubungi Microsoft 

Check for Updates Memeriksa jika ada tambahan baru dari Microsoft 

Detect and Repair Mendeteksi dan memperbaiki dokumen yang rusak 

Active Product Mengaktifkan produk Microsoft Office 

Customer Feedback Memberikan kesempatan kepada pengguna PowerPoint untuk 
memberikan u ada Microsoft Option mpan balik kep

About Microsoft 
Office PowerPoint 

Informasi tentang PowerPoint 2003 
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Gambar Langkah mengaktifkan Menu Toolbar. 
etika PowerPoint pertama kali dinyalakan, secara otomatis akan muncul toolbar 
tandard dan Formating. Toolbar yang ada di Power Point adalah : 
 Toolbar Standard, berisi tombol-tombol yang umumnya digunakan untuk aktivitas 

enyuntingan 
 
 
 

• oolbar Formating, berisi tombol-tombol yang  digunakan untuk format dokumen  

 
  
• Control Toolbo radio, check box 

• 
 
 

• Outlining, berisi tombol-tombol untuk mengatur outline. 
 

 
Gambar  Keadaan icon Aktif 

Penggunalah yang memutuskan toolbar mana yang akan ditampilkan pada layar. 
Untuk mengaktifkan masing-masing Toolbar, gunakan Menu View, Toolbar, 
kemudian tandai nama Toolbar yang ingin ditampilkan, sehingga mu
didepan nama jenis toolbar. 
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x, berisi kontrol-kontrol masukan seperti text box, 
dan lainnya. 

 
 
 

Drawing, berisi kontrol-kontrol untuk menggambar 

 



 
 
• Picture, berisi tombol-tombol untuk mengatur tataletak gambar yang ada pada 

dokumen 
 
 
 

• Reviewing, berisi tombol-tombol yang berhubung-an dengan pelacakan dokumen 
 
 
 

perubahan yg dilakukan pada slide. 
• Table and Borders, berisi tombol-tombol untuk mengatur tata letak tabel. 

 

 
• Task Pane, menampilkan atau menyembunyikan task pane. 
• Visual Basic, berisi tombol-tombol yang digunakan untuk membuat macro. 

 

 
• Web, berisi kontrol-kontrol web broser, seperti address bar, favorite, home dan 

lainnya. 

 

 

 
 
 

 
 
Pemilihan Toolbar 

tempuh melalui 
langkah berikut : 
 
 

 
 
 
 
 
 
 

• Revision, menampilkan panel yang berisikan pelacakan terhadap perubahan-

 

 

 

 
• Word Art, berisi tombol-tombol untuk mengaktifkan fitur WordArt. 

 
 
 

• Customize, berisi semua toolbar, command, dan option.  

 
 

Untuk mengaktifkan dan menonaktifkan suatu toolbar dapat di

 



 
 
 
 
 
 
 

 
Click View, Toolbars, Customize. 
Klik View, Toolbars, Customize. 

 
The Customize dialog box opens. Click the Toolbars tab. 
Kotak dialog Customize akan terbuka. Klik tab Toolbar. 

 
Click the toolbar you want to customize. 
Klik toolbar yang ingin Anda kustomkan. 

 
Click the Commands tab. 
Klik tab Commands. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 

 
Select the category and button you want to add to the toolbar. 
(Categories group similar commands together, often by menu name.) 
Pilih kategori dan tombol yang ingin Anda tambahkan ke toolbar. 
(Kategori mengelompokkan perintah yang mirip menjadi satu yang 
seringkali menurut nama menu. 

 
Drag the selected button from the list, and drop it onto the toolbar 
where you want it to appear. 
Geret tombol terpilih dari daftar, dan jatuhkan dia ke toolbar tempat 
yang Anda inginkan toolbar itu muncul. 

 
Click Close. 
Klik Close. 

 
The button appears on the toolbar. 



Tombol ini akan muncul di toolbar. 
 
Pemak i
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a an Task Pane 
akai task pane dapat dilakukan melakui cara sebagai berikut : 

 

 

 

 
 
 
 
 
 
 

 
If two or more panes are open at the same time, you can click the 
navigation buttons to move between them. 
Bula dua panel atau lebih terbuka sekaligus, Anda dapat mengklik 
tombol navigasi untuk memindah-mindahkan ke sana kemari. 

 
You can click a link to activate a feature, or you can select from 
available options. 
Anda dapat mengklik tautan untuk mengaktifkan fitur, atau Anda dapat 
memilih dari opsi yang tersedia. 

 
To open a particular pane, click the Other Task Panes button (the down 
arrow button in the upper-right corner of the Task pane), and then click 
the pane you want to view. 
Untuk membuka panel tertentu, klik tombol Other Task Panes (tombol 
panah turun di pojok kanan atas jendela Task), lalu klik jendela yang 
ingin Anda lihat. 

 
The new pane's contents appear in the Task pane. 
Isi panel baru akan muncul di jendela Task. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
To close the pane, click the Close button 
Klik tombol Close untuk menutup pane 

 
PowerPoint closes the pane area. To display the Task pane again, select View, 
Task Pane 
PowerPoint menutup pane. Untuk menampilkan kembali pilih View, Task 
Pane 

 
The Task pane opens again, displaying the Getting Started pane 
Task pane terbuka kembali dengan tampilan pane Getting Started  

 

Mengubah Penampakan PowerPoint 
Cara mengubah penampakan Power Point dilakukan dengan langkah berikut : 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Normal view displays by default. To view another slide in your 
presentation, click the slide in the Slides tab. 
Tampak normal akan tampil secara default. Untuk melihat slide lain 
dalam presentasi, klik slide di tab Slides 

 
PowerPoint displays the slide. To view all the slides, click the Slide 
Sorter View button. 
PowerPoint menampilkan slide. Untuk melihat semua slide, klik tombol 
Slide Sorter View. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
PowerPoint displays all the slides in your presentation. Click the Slide 
Show View button. 
PowerPoint menampilkan semua slide dalam presentasi Anda. Klik 
tombol Slide Show View. 

 
PowerPoint displays your presentation in full-screen mode. Click 
anywhere onscreen or press Enter to advance each slide, or press Esc 
to exit at any time. 
PowerPoint akan menampilkan presentasi Anda dalam mode layar 
penuh. Klik sembarang di layar atau tekan Enter untuk ke slide 
berikutnya, atau tekan Esc untuk keluar. 

Mengecilkan dan Membesarkan Tampilan 
Untuk mengatur besar kecilnya tampilan slide di layar lakukan langkah berikut : 
 

 
To zoom in, click the Zoom drop-down arrow and select a zoom 
percentage. 
Untuk memperbesar, klik panah drop-down Zoom dan pilih persentase 
perbesaran. 

 
PowerPoint zooms your view of the slide. 
PowerPoint akan memperbesar tampak slide Anda. 

 
To return a slide to its regular size, click the Zoom drop-down arrow and 
select Fit. 
Untuk mengembalikan slide ke ukuran biasa, klik panah drop-down 
Zoom dan pilih Fit. 



 
PowerPoint displays the entire slide in the Slide pane. 
PowerPoint akan menampilkan seluruh slide dalam panel Slide. 

 

 
 
Mendapatkan Bantuan 
Untuk mencari bantuan pada Power Point lakukan langkah berikut: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
Click inside the Ask A Question box; type a question, word, or phrase 
you want to find help with; and press Enter. 
Klik di dalam kotak Ask A Question; ketikkan pertanyaan, kata atau 
frasa yang ingin Anda cari bantuannya; dan tekan Enter. 



 
The Search Results pane appears with a list of possible matches. Click 
a topic. 
Panel Search Results akan muncul dengna daftar kecocokan yang 
mungkin. Klik satu topik. 

 
A Help window opens with information about the chosen topic. You can 
read the information and use the scrollbars to view more. 
Jendela Help terbuka dengan informasi tentang topik yang dipilih. Anda 
dapat membaca info itu dan memakai scrollbar untuk melihat lebih jauh.

 
Click the window's Close button to exit the Help file. 
Klik tombol Close window untuk keluar dari file Help. 

 



Operasi Dasar Power Point 
 
 
Memulai Power Point 
1. Hidupkan komputer hingga posisi siap dengan tampilan windows. Untuk memulai 

Power Point ada beberapa tahap yang harus dilakukan, yaitu: 
Buka Start Menu, dan pilih Programs, Microsoft Power Point (Lihat gambar 3). 
Setelah itu akan muncul kotak dialog Power Point, yang mana nantinya akan 
diberikan 4 pilihan, dan kita dapat memilih salah satu options tersebut: Auto 
Content Wizard, Template, Blank Presentation, atau Open Existing Presentation. 

2. Setelah kita pilih salah satu, klik OK atau tekan Enter. Selanjutnya, akan muncul 
layar New Slide dan tentukan AutoLayout yang kita inginkan. 

3. Pilih OK atau tekan Enter. 
Uraian tersebut secara rinci dapat dijelaskan seperti berikut :  
Cara 1 : 

 
 
 
 
 
 
 
 
 

 
Klik tombol Start 

 
Klik All Programs atau Programs 

 
Klik Microsoft Office, Microsoft Office PowerPoint 

 
Jendela program PowerPoint terbuka dan tombol taskbar program 
PowerPoint muncul pada taskbar Windows 

 
Cara 2: 
Double Klick ikon shortcut PowerPoint pada jendela desktop 
 
Cara 3: 
Double Klick ikon PowerPoint pada menu Start 
 



MEMBUKA PRESENTASI  
Saat PowerPoint dijalankan, kotak dialog PowerPoint akan muncul pada layar. Ada 
empat pilihan pada kotak dialog ini, meliputi Blank Presentation, From Design 
Template, From AutoContent Wizard, dan Open Existing Presentation. 
Bila kita ingin memakai file-file presentasi yang sudah disediakan oleh PowerPoint, 
pilih Template. Bila ingin membuat presentasi dari halaman "kosong" tanpa warna 
atau style, pilih Blank Presentation. Sementara bila kita membutuhkan panduan 
tahap demi tahap selama pembuatan, pilihlah AutoContent Wizard. 

 

 

 

 

 

 

 

 

 

1. PILIHAN BLANK PRESENTATION 
Bila kita memilih ini, pada kotak dialog PowerPoint akan muncul kotak dialog New 
Slide. Kita bisa memilih salah satu tata letak presentasi yang tersedia. 

 

 

 

 

 

 

 

 

 

Tata letak slide dapat diubah setiap saat, caranya klik menu Format, Slide Layout 
atau dengan menekan tombol Slide Layout pada status bar. Setelah slide dibuat, kita 



bisa menyisip slide baru dengan mengklik menu Insert, New Slide atau dengan 
mengklik tombol New Slide pada Toolbar standard. 
 
2. PILIHAN TEMPLATE  
Bila kita menggunakan ini untuk membuat presentasi baru, kita tinggal mengklik 
ganda salah satu icon template yang tersedia pada kotak dailog New Presentation. 
Ada empat kelompok template, yaitu: 
• General berisi presentasi kosong. 
• Presentation Design berisi lebih dari 20 design template professional 
• Presentations berisi template presentasi yang siap diatur dan memiliki tema 

khusus. 
• Web Pages berisi template presentasi untuk keperluan publikasi dalam Internet. 
Untuk mengganti Template, klik menu Format, Apply Design Template. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



3. PILIHAN AUTOCONTENT WIZARD 
Bila kita memilih ini, pada layar akan muncul secara berurutan enam buah kotak 
dialog dengan berbagai pilihan dan kotak isian di dalamnya. Berikut ini langkah 
sistematisnya: 
a. Pada kotak dialog pertama langsung saja klik Next, karena hanya berisi 

penjelasan seputar AutoContent Wizard. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
b. Pada kotak dialog kedua, pilih jenis presentasi yang diinginkan. Kemudian pada 

daftar yang tampil disamping, pilih yang lebih spesifik. Klik Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
c. Pilih tempat dimana kita akan melakukan presentasi. Ada 2 pilihan, yaitu: 

Presentations, jika akan dilakukan dalam kontak langsung, atau Internet, jika 
presentasi akan dilakukan melalui saluran Internet. 

 
 
 
 
 
 
 
 
 
 
 
 
 



d. Ketikkan judul presentasi pada kotak Presentation Title, dan nama pada kotak 
Your Name. Sedangkan informasi lain dimasukkan kekotak Additional information. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
e. Pada kotak terakhir, langsung klik tombol Finish. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Hasilnya seperti berikut : 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



4. PILIHAN OPEN AN EXISTING PRESENTATION  
Selain membuat presentasi baru, kita juga bisa membuka file-file yang telah dibuat 
sebelumnya yang tersimpan pada Harddisk dan Disket. Pada layar akan muncul 
kotak dialog Open. Kita bisa mencari file presentasinya. 
 
Memahami Elemen Slide  

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Just about every slide in a presentation includes text. Text boxes allow 
you to enter words and paragraphs into your slide. 
Hampir setiap slide mengandung teks. Kotak teks memungkinkan Anda 
untuk memasukkan kata-kata dan paragraf ke dalam slide Anda. 

 
You can use bulleted lists to present data succinctly and focus the 
audience on specific points you want to make. 
Anda dapat memakai daftar plentong untuk menyajikan data secara 
fokus dan ringkas. 

 
You can use clip art to illustrate your slides. 
Anda dapat memakai clip art untuk memberi ilustrasi. 

 
You can use charts to present data in a visual manner. 
Anda dapat memakai diagram untuk menyajikan data secara visual. 

 
You can add tables to your slides to organize and present data in an 
easy-to-read format. 
Anda dapat menambahkan tabel ke slide untuk mengorganisasi dan 
menyajikan data dalam format yang mudah dibaca. 

 
Content boxes allow you to choose the type of object you want to add, 
such as a media clip, a diagram, or a picture file from another source. 
Kotak konten memberi pilihan tipe objek yang ingin Anda tambahkan, 
seperti media clip, diagram, atau file gambar dari sumber lain. 



Mengganti Wadah Teks  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click the text box to which you want to add text. The slide element is 
immediately surrounded by selection handles (tiny square boxes at 
each corner of the text box). 
Klik kotak teks yang ingin Anda tambahi teks. Elemen slide dikelilingi 
dengan handel pemilihan (kotak bujur sangkar kecil pada setiap sudut 
kotak teks). 

 
Type the text you want. 
Ketikkan teks yang Anda kehendaki. 

 
Menambah Slide Baru 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click the New Slide button on the Formatting toolbar. 
Klik tombol New Slide pada Formatting toolbar. 

 
PowerPoint immediately opens the Slide Layout pane. Click a layout, 
and the new slide is ready to go. 
PowerPoint langsung membuka panel Slide Layout. Klik layout, dan 
slide baru akan siap dibuat. 



Mengubah Layout Slide 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click the slide you want to change. 
Klik slide yang ingin Anda ubah. 

 
From the Task pane, click the Other Task Panes button (the down 
arrow in the pane's upper-right corner), and then click Slide Layout. 
Dari panel Task, klik tombol Other Task Panes (panah turun di panel 
pojok kanan atas) lalu klik Slide Layout. 

 
The Slide Layout pane appears. Scroll through the available layouts 
and click the one you want to assign. 
Muncul panel Slide Layout. Gulung dengan melihat layout yang ada 
dan klik layout yang ingin Anda pakai. 

 
PowerPoint assigns the layout to the current slide. 
PowerPoint akan memberlakukan layout itu ke slide saat itu. 

 
Menyimpan File Presentasi 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
Click the Save button on the Standard toolbar. 
Klik tombol Save pada Standard toolbar. 

 
The Save As dialog box opens. Type a name for the presentation. 
Kotak doalog Save As terbuka. Ketik nama presentasi. 

 
To save the file in another folder, click the Save In drop-down arrow 
and select another folder or drive. 
Untuk menyimpan file ke folder lain, klik panah drop-down Save In dan 
pilih folder atau drive lain. 

 
Click Save. PowerPoint saves the presentation. 
Klik Save. PowerPoint akan menyimpan presentasi. 

 
Membuka dan Menutup File Presentasi 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click the Open button on the Standard toolbar. 
Klik tombol Open pada Standard toolbar. 

 
The Open dialog box opens. Click the file you want to open to select it. 
Kotak doalog Open terbuka. Klik file yang ingin Anda buka. 

 
To locate the file in another folder or drive, click the Look In drop-down 
list, navigate to the folder or drive, and then select the file. 
Untuk membuka file di folder atua drive lain, klik daftar drop-down Look 
In, arahkan ke folder atua drive, lalu pilih file. 

 
Click Open. PowerPoint opens the presentation. 
Klik Open. PowerPoint akan membuka presentasi. 

 
To close a presentation, click the file's Close button. 
Untuk menutup presentasi, klik tombol Close. 

 
PowerPoint immediately closes the presentation. 
PowerPoint akan langsung menutup presentasi. 



Navigasi Diantara Slide 

 
 
 
 

 
In the Slides tab, click the slide you want to view. 
Dalam Slide tab, klik slide yang ingin Anda lihat. 

 
The slide immediately appears in the work area, also called the Slide 
pane. 
Slide muncul di area kerja atau panel Slide. 

 
Click the Next Slide button to display the next slide in the presentation. 
Klik tombol Next Slide untuk menampilkan slide berikutnya dalam 
presentasi. 

 
The next slide is displayed. 
Tampil slide berikutnya. 

 
Click the Previous Slide button to move back a slide. 
Klik tombol Previous Slide untuk ke slide sebelumnya. 

 
The previous slide is displayed. 
Tampil slide sebelumnya. 

 
You can also drag the scrollbar to navigate forward and backward in 

eret scrollbar untuk menavigasi maju mundur 
dalam presentasi Anda. 

empasword File Presentasi 
 

your presentation. 
Anda dapat juga mengg

 
M

 
 



 

 
Open the Tools menu and click Options. 
Buka menu Tools dan klik Options 

 
The Options dialog box opens. Click the Security tab, click inside the 
Password to Open box, and type a password. 
Kotak dialog Options terbuka. Klik Security tab, klik di dalam kotak 
Password to Open, dan ketikkan password 

 
Click OK. 
Klik OK. 

 
The Confirm Password dialog box opens. Type the password again and 
click OK. 
Kotak dialog Confirm Password terbuka. Ketikkan password sekali lagi 
dan klik OK. 

 
To test the password, save and close your presentation, and then open 
it again. The Password dialog box appears. 
Untuk mengetes password, simpan dan tutup presentasi Anda, lalu 
buka lagi. Muncul kotak dialog Password. 

 
Type the password and click OK. 
Ketikkan password dan klik OK. 

 
PowerPoint opens the presentation. 
PowerPoint akan membuka presentasi. 

 
Menutup Power Point 
Untuk menutup program aplikasi Power Point dapat dilakukan dengan cara berikut : 
Cara 1: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Klik menu File dalam program Power Point 

 
Klik Exit 

 
Jendela Power Point tertutup dan tombol taskbar program Power Point 
tidak nampak lagi pada taskbar Windows 

 
Cara 2: 
Cara cepat dengan mengklik tombol Close ( ) diujung kanan atas program Windows, 
maka Power Point akan tertutup. 



Ekplorasi Menu Power Point 
Membuat Presentasi Baru 
Setiap kali membuka aplikasi PowerPoint, sebuah slide kosong yang baru telah 
tersedia dan siap untuk didesain, akan tetapi kemungkinan slide yang telah disiapkan 
tersebut tidak sesuai dengan desain yang hendak dirancang. Oleh karena itu diatur 
baik teks, background, dan layoutnya agar sesuai dengan yang diinginkan. 
Untuk membuat slide baru, kita aktifkan menu File > New  seperti dalam slide berikut : 

 

 
 
 
Caranya dari posisi aplikasi power point, pindahkan pointer mouse ke menu File 
lalu tombol mouse kiri di klik kemudian pointer digeser ke item New kemudian 
tombol mouse kiri diklik. 

Task Pane 

 
Cara lain dapat juga menggunakan tombol New pada Toolbar seperti berikut : 



Arahkan pointer mouse ke tombol New, kemudian klik mouse.  
 

 
 
di layar monitor akan tampak penampilan sebagai berikut : 
 

 
 
 Task Pane 
 
Terlihat tampilan task pane yang muncul berbeda dengan cara yang pertama. 
 
Membuat Slide Baru 
Untuk membuat slide baru agar sesuai dengan keinginan, maka terlebih dahulu kita 
tentukan format slidenya dengan cara :  
klik menu File > Page Setup hingga muncul dialog Page Setup sebagai berikut: 



   
 
Atur atau tentukan ukuran, penomoran dan orientasi slide dengan cara mengisi atau 
memilih isian yang tersedia pada kotak dialog tersebut. Ukuran slide dapat 
ditentukan dengan mengubah bagian Slide sized for. On-screen Show merupakan 
format default. Kita bisa mengubahnya dalam format ukuran kertas standard A4, B4, 
B5 dan lainnya. Orientasi slide juga dapat ditentukan pada bagian Orientation, yaitu 
dengan mengklik salah satu dari pilihan slide Potrait atau Lanscape. Selain itu juga 
catatan atau keterangan pada slide juga dapat ditentukan pada Notes, handouts & 
outline, yaitu dengan mengklik salah satu dari pilihan slide Potrait atau Lanscape. 

 
 
Layout Slide 
Setelah ukuran slide ditentukan, langkah berikutnya adalah menentukan tata letak 
atau layout slide.   
Pada prinsipnya layout slide ditentukan oleh jumlah, tataletak dan jenis 
placeholdernya. Placeholder sendiri merupakan suatu bingkai yang ke dalamnya 
dapat dimasukan teks atau objek-objek presentasi lainnya. Untuk menentukan layout 
slide, aktifkan menu Format > Slide dengan cara mengkliknya. Selanjutnya pada 
bagian Task Pane akan muncul bagian Slide Layout. Untuk menerapkan suatu layout 
yang tersedia, kita tinggal mengklik icon layout yang tersedia di Task Pane seperti 
yang diperlihatkan dalam slide berikut: 

 
Text Layout 
Layout ini digunakan hanya untuk menampilkan teks saja. Bentuk yang tersedia 
pada katagori ini adalah: 
 
 



Title Slide, menampilkan dua buah place holder 
teks dengan ukuran besar, digunakan untuk 
menulis judul presentasi. 
Title Only, menampilkan placeholder teks di 
bagian atas slide, digunakan untuk menuliskan 
judul presentasi atau judul slide. 
Title and Text, menampilkan placeholder teks di 
bagian atas untuk judul slide dan dibagian 
bawah digunakan untuk menuliskan item-item 
penjelasan judul. 
Title and 2-Column Text, menampilkan 
placeholder teks di bagian atas untuk judul slide 
dan bagiam bawah yang terbagi menjadi dua 
kolom digunakan untuk menuliskan item-item 
penjelasan judul. 
 
Content Layout 
Layout ini digunakan untuk menampilkan objek-
objek presentasi tertentu (seperti tabel, diagram 
gambar, clip art dan lainnya) ke dalam slide. 
Bentuk layout yang tersedia adalah,  
Blank, slide kosong dan objek dimasukan 
secara manual 
Content, berisi sebuah placeholder untuk 
menam-pilkan objek presentasi 
Title and Content, bagian atas berupa 
placeholder teks untuk menuliskan judul dan 
bagian bawah berisi place holder untuk 
menampilkan objek presentasi 
Title and 2 Content, bagian atas berupa 
placeholder teks untuk menuliskan judul dan 
bagian bawah berisi place holder untuk 
menampilkan objek presentasi. 
Title, Content and 2 Content, bagian atas 
berupa placeholder teks untuk menuliskan judul 
dan bagian bawah terdiri dari tiga placeholder 
(satu di kiri dan dua di kanan) untuk 
menampilkan objek presentasi. 
Title, 2 Content and Content, bagian atas 
berupa placeholder teks untuk menuliskan judul 
dan bagian bawah terdiri dari tiga placeholder 
(dua di kiri dan satu di kanan) untuk 
menampilkan objek presentasi. 
Title and 4 Content, bagian atas berupa 
placeholder teks untuk menuliskan judul dan 
bagian bawah terdiri dari empat placeholder 
untuk menampilkan objek presentasi. 
 
 
 
 
 



 
 Layout lainnya bisa dilihat sendiri. 
 Jika layout yang tersedia tidak memenuhi selera atau kebutuhan kita, kita dapat 

membuat dan mengatur sendiri place holder yang dibutuhkan. 
 Caranya adalah : aktifkan menu Format > Slide Layout, kemudian pilih Content 

Layout Blank dengan cara mengkliknya. Slide akan tampak kosong.  
 Selanjutnya aktifkan Insert > Text Box. Pointer mouse akan berubah bentuk 

menjadi anak panah tipis 
 Pada saat pointer mouse berbentuk seperti anak panah, tempatkan pointer 

tersebut pada slide. Kemudian klikan mouse dan tarik pointer tersebut untuk 
mendapatkan sebuah placeholder.   
 

Desain Slide 
 PowerPoint menyediakan berbagai macam template desain slide. Dalam desain 

slide tersebut ada beberapa hal yang diatur yaitu warna gambar latar belakang 
(background), jenis,  ukuran dan warna font. 

 Untuk menentukan desain slide, aktifkan menu Format > Slide Design 
 Maka pada task pane akan tampil pilihan slide design seperti yang diperlihatkan 

dalam slide berikut. 
 Untuk memilih desain yang ada, arahkan pointer kepada salah satu desain 

tersebut kemudian klikan mous, maka letarbelakang slide akan berubah seperti  
desain yang kita pilih.  

 
 
 
 
 

Icon untuk memilih 
desain slide 

  
Teks, Background, Layout 
Buat/pilih placeholder teks, kemudian tuliskan teks dalam placeholder tersebut, misal 
seperti berikut : 



 
 
 

emilih Teks 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
M

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click the text block you want to edit 

 
Click and drag across the text you want to select 

 
PowerPoint immediately highlights the selected text onscreen 

 
 
 
 



Menghapus Teks 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Select the text you want to delete 

 
Press the Delete key on your keyboard 

 
PowerPoint removes the text 

 
Memin a

 

d h dan Menyalin Slide Teks 

Select the text you wa
 

nt to move or copy 

 
To move the text, click the text and drag it to a new location. To copy 

nd dragging the text, press the Ctrl key while clicking a

 
Drop the text where you want it to go. PowerPoint moves or copies the 
text 

 
To move or copy the text using the Cut, Copy, and Paste commands, 
first select the text you want to move or copy 

 
Click the Cut button to move the text or click the Copy button to copy 
the text 

 
Click the spot on the slide where you want to place the text 



 
Click the Paste button. PowerPoint moves or copies the text 

 
Menyisipkan Simbol 

 

 
Click in the slide text where you want to insert a symbol 

 
Open the Insert menu and choose Symbol 

 
The Symbol dialog box opens. Click the Font drop-down arrow and click 
the font you want to display 

 
Click the symbol you want to use 

 
Click Insert. PowerPoint adds the symbol to your slide 

 
Click Close to exit the dialog box 

 
The symbol appears in the text 

 
 
Menamb

 

ah Tek Box Baru 

 
Click the Text Box button on the Drawing toolbar 

 
Click and drag the mouse on the slide where you want the text box to 
appear until the text box is the size you want 



 
Release the mouse button; the text box is created 

 
Type the text you want to include in the text box 

 
Click anywhere outside the text box to deselect the text object 

 
 
Bullet da

 

n Numbering 

 
To add bullets, click the text box you want to change 

 
Click the Bullets button on the Formatting toolbar 

 
PowerPoint inserts bullets in front of each line of text 

 
To add numbers, click the text box you want to change 

 
Click the Numbers button on the Formatting toolbar 

 
PowerPoint inserts numbers in front of each line of text 

 
Kusto i

 
 
 

m sasi Bullet 

 
 



 
Click the text box you want to change 

 
Open the Format menu and choose Bullets and Numbering 

 
PowerPoint opens the Bullets and N
Bulleted tab 

umbering dialog box. Click the 

 
Click the bullet style you want to apply and click OK to apply it to the 
text box 

 
To further customize the bullet style, click the Customize button 

 
The Symbol dialog box opens. Select a font from the Font drop-down 
list 

 
Click a bullet type and click OK to close the Symbol dialog bo
then click OK again to close the Bullets and Numbering dialog box 

x, and 

 
PowerPoint applies the customized bullet to the list 

 
Penga
 
 

turan Perataan Teks 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click the text box whose alignment you want to change 

 
Click the Align Left button in the Formatting toolbar to align text to the 
left 

 
Click the Center button to center text in the text box 

 
Click the Align Right button to align text to the right 

 
 
 
 
 
 



Indenting Teks 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click in front of the line of text to be indented 

 
Click the Increase Indent button in the Formatting toolbar to indent the 
text 

 
PowerPoint indents the text 

 
Click the Decrease Indent button to decrease the indent 

 
Mengu a
 
 

b h Spasi 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Select the text or text box you want to edit 

 
Open the Format menu and choose Line Spacing 

 
The Line Spacing dialog box opens. Clic
change the amount of spacing between line

k the up or down arrow to 
s of text, and then click OK 

 
PowerPoint adjusts the line spacing 

 
Mengu a
 
 

b h Style Teks 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Select the text you want to format 

 
Click the appropriate style button (Bold to make text bold, Italic to 
italicize the text, Underline to add underlining to the text, or Shadow to 
add a shadow to the text). 

 
PowerPoint applies the selected style to the text. In this example, the 

 
Mengubah Jenis dan Ukuran Font 

text is italicized 



 
Select the text or text box you want to edit 

 
Click the Font drop-down list on the Formatting toolbar 

 
Click a new font 

 
PowerPoint applies the new font to the text 

 
To change the font size, click the Size drop-down list on the Formatting 
toolbar 

 
Click a new size 

 
PowerPoint applies the new size to the text 

 
Mengubah Warna Teks 
 

 
 

 
Select the text or text box you want to format 

 
Click the Font Color button on the Formatting toolbar 

 
PowerPoint displays a menu of color options that coordinate with your 
current slide design. Click the color you want to apply 

 
If you do not see a color you like, click More Colors 

 
The Colors dialog box opens. Click a color 

 
Click OK 

 
PowerPoint applies the color 

 
 
 
 
 
 
 
 
 
 
 



Mengubah Warna Latar Belakang Tek box 

 
 

 
Select the text box you want to edit 

 
Open the Format menu and choose either Text Box or Placeholder 

 
The Format dialog box opens. (The dialog box will be labeled Format 
AutoShape or Format Text box, depending on the type of box you 

es tab selected.) Click the Colors and Lin

 
Click the Color drop-down arrow 

 
Click a color, and click OK 

 
The background color is applied behind the text box 

ek Ejaan 

 

 
 
C

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Click the Spell Check button on the Standard toolbar 

 
PowerPoint launches the spell check. If it finds an error, it highlights the 
misspelled word and opens the Spelling dialog box 

 
Click a correct spelling from the list of suggestions 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click the Spell Check button on the Standard toolbar 

 
PowerPoint launches the spell check. If it finds an error, it highlights the 
misspelled word and opens the Spelling dialog box 

 
Click a correct spelling from the list of suggestions 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Contoh : 
Buatlah sebuah presentasi kosong yang terdiri dari tiga buah slide dengan ketentuan 
sebagai berikut : 
Menggunakan pilihan Blank Document.  
Ketikkan baris pertama Microsoft Office dan baris kedua Power Point pada slide 
pertama  
Ketikkan pada baris pertama Microsoft Office dan baris kedua :  
1. Microsoft Word  
2. Microsoft Excell  
3. Microsoft PowerPoint  
pada slide kedua 
Pada slide ketiga ketikkan: 
Program Komputer 
1. Sistem Operasi 

 Dos 
 Windows 
 Linux 

2. Program Aplikasi 
 Microsoft Office 
 SPSS 
 Corel Draw 

3. Bahasa Pemrograman 
 Basic 
 Pascal 
 Fortran 

 
Langkah Pengerjaan 
1. Buka Program Power Point 
2. Klik tombol New pada toolbar 
Teks dan Layout Teks 
3. Pada task pane Slide Layout pilih Title Slide (Apply to Selected Slides) di bagian 

Teks Layout 
4. Klik placeholder Click to add title, hingga berubah kotak segi empat kemudian 

ketik Microsoft Office 
5. Klik placeholder Click to add subtitle, hingga berubah kotak segi empat kemudian 

ketik Power Point 
6. Klik tombol New Slide pada toolbar 
 
Bullet & Numbering 
7. Pada task pane Slide Layout pilih Title and Text (Apply to Selected Slides) di 

bagian Teks Layout 
8. Klik placeholder Click to add title, hingga berubah kotak segi empat kemudian 

ketik Microsoft Office 
9. Klik placeholder Click to add text, hingga berubah kotak segi empat kemudian 

ketik 
• Microsoft Word  
• Microsoft Excell  
• Microsoft PowerPoint  

10. Blok tulisan 
• Microsoft Word  
• Microsoft Excell 
• Microsoft PowerPoint  



11. Arahkan pointer mouse ke toolbar tombol Numbering, lalu klik tombol kiri mouse 
maka tulisan akan menjadi    
1. Microsoft Word  
2. Microsoft Excell  
3. Microsoft PowerPoint  

12. Ulangi langkah 4 sampai dengan 6 pada langkah 5 ketik tulisan Program 
Komputer dan pada langkah 6 ketik tulisan 
• Sistem Operasi 
• Dos 
• Windows 
• Linux 
• Program Aplikasi 
• Microsoft Office 
• SPSS 
• Corel Draw 
• Bahasa Pemrograman 
• Basic 
• Pascal 
• Fortran 

13. Blok tulisan diatas kemudian arahkan pointer mouse ke toolbar tombol Numbering, 
lalu klik tombol kiri mouse maka tulisan akan menjadi  
1. Sistem Operasi 
2. Dos 
3. Windows 
4. Linux 
5. Program Aplikasi 
6. Microsoft Office 
7. SPSS 
8. Corel Draw 
9. Bahasa Pemrograman 
10. Basic 
11. Pascal 
12. Fortran 

14. Blok tulisan Dos sampai Linux lalu klik menu format  pilih Bullets and Numbering, 
arahkan pointer mouse ke Bulleted dan klik, kemudian pilih picture. Pada jendela 
Picture Bullet bagian search text: ketik arrows terus klik Go muncul gambar . 
Arahkan pointer mouse ke gambar tersebut lalu klik, terus pilih tombol Ok.   

15. Klik tombol Increase Indent pada toolbar, maka tampilan tulisan akan seperti 
berikut : 
1. Sistem Operasi 

 Dos 
 Windows 
 Linux 

16. Ulangi langkah 11 dan 12 diatas untuk tulisan Microsoft Office sampai Corel Draw 
dan Basic sampai Fortran. 

 
Mengatur Tek (jenis, style, ukuran, efek, dan warna) 
17. Mengatur tek yang meliputi jenis, style, ukuran, efek, dan warna dari tek tersebut 

dapat dilakukan dengan cara blok bagian teks yang hendak diatur, kemudian pilih 
menu Format. Pilih Font pada menu Format tersebut maka akan muncul jendela 
Font. Pilihlah jenis, style, ukuran, efek, dan warna dari tek sesuai dengan 



keinginan kita pada jendela Font ini kemudian klik Ok. Lakukan langkah ini pada 
setiap huruf/kata/kalimat/seblok tek dalam satu placeholder yang ingin diatur jenis, 
style, ukuran, efek, dan warnanya. Pengaturan ukuran tek ini berpengaruh 
terhadap ukuran placeholdernya. Sehingga pengaturan ukuran tek ini biasanya 
diikuti pula dengan pengaturan ukuran placeholder (wadah tek) nya. 

 
Mengatur Background 
18. Untuk mengatur background (latarbelakang) teks dilakukan dengan cara klik 

placeholder tempat tek yang akan diatur backgroundnya. Klik tombol Fill Color 
pada toolbar. Pilih warna background yang sesuai lalu klik Ok. Pilihan ini dapat 
berupa warna saja atau warna dan jenis efeknya. Cara lain yaitu dengan memilih 
Placeholder pada menu Format. Kemudian atur warna pada bagian Fill di jendela 
Format AutoShape bagian Colors and Lines. 

 
Mencetak Slide atau Handout 
Hasil Presentasi yang dibuat dapat dicetak dalam kertas dengan memakai printer. 
Cetakan dapat berupa Slide (1 halaman berisi 1 Slide), Handout (1 halaman berisi 1-
9 Slide), Notes page (1 halaman berisi 1 Slide beserta catatannya) , atau Outline 
(Tampilan Outline). Adapun langkah dalam mencetak adalah sebagai berikut : 

 

 
Open the File menu and choose Print 

 
PowerPoint opens the Print dialog box 

 
Click the down arrow next to the Print What field and select the 
presentation item you want to print. In this example, Slides is selected 

 
Click a print range. You can choose to print just the current slide, all the 
slides in the presentation, or selected slides 



 
 
 
 

 

 
To print specific slides, click the Slides option and type the slide 
numbers 

 
Click the down arrow next to the Color/grayscale field and select 
whether you want to print color, grayscale, or black and white printouts 
of your slides 

 
Click OK to start printing the slides 

 

aftar Pustaka 
2003, Easy Microsoft Office PowerPoint 2003, Que, United States of 

 
itra, 2006, Menciptakan Presentasi Multimedia yang Menarik, http://media-

 
 
D
Kinkoph Sherry, 

America. 

P
ide.bajingloncat.com/2006/05/08/menciptakan-presentasi-multimedia-yang-
menarik 

 
 



Handout 6 
Drawing and Equation 

 Drawing: membuat, mengedit, grouping 

 Wordart 

 Clipart 

 Equation Editor 

 Tugas 

Drawing 
Drawing toolbar dapat kita manfaatkan untuk menggambar bangun. Fasilitas ini 
biasanya terletak di pojok kiri bawah. 

 
Gambar: Drawing Toolbar biasanya ada di pojok kiri bawah. 

Membuat bangun  
Drawing Toolbar sudah menyediakan fasilitas untuk membuat bentuk-bentuk: 
AutoShapes, garis, garis dengan anak panah, segi empat, elips, Text Box, WordArt, 
dan Diagram/Organizational Chart. 

 

Untuk membuat gambar bangun, misalnya elips, pada sebuah slide, kita bisa 
melakukannya seperti berikut. 
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Langkah: 

 
Klik salah satu drawing tool pada Drawing toolbar. Dalam contoh ini, kita 
memilih Oval tool. 

 
Klik dan drag pada slide untuk menggambar bangun itu. 

 
Lepaskan tombol mouse, gambar akan terbentuk. 

 

Kita dapat menggambar sendiri ilustrasi dengan memakai tool yang tersedia di 
Drawing toolbar. Toolbar ini berisi tombol-tombol untuk menggambar bangun-
bangun (bentuk) sederhana, seperti oval dan empat persegi panjang, di 
samping garis dan garis dengan anak panah. Kita dapat mengontrol warna 
garis dan ketebalan bangun di samping mengisi warna ke dalam bangun itu. 

 

Cara menggambar bentuk sempurna: 

Untuk menggambar lingkaran atau persegi sempurna, tekan dan tahan tombol 
Shift saat Anda menggambar dengan tool Oval atau Rectangle. 

 

Cara menggambar garis: 

Untuk menggambar sebuah garis atau sebuah garis dengan anak panah, Anda 
cukup meng-klik tombol Line atau Arrow pada Drawing toolbar dan drag pada 
slide untuk membuat garis itu. 
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Mengedit bangun 
Kita akan mewarnai isi bangun, mewarnai garis batas bangun, dan mengubah 
ketebalan atau gaya garisnya. 

 
 

 
Klik panah turun di sebelah tombol Fill color pada Drawing Toolbar dan klik 
salah satu warna untuk mengisi warna bangun.  

 
Klik panah turun di sebelah tombol Line color pada Drawing Toolbar dan klik 
salah satu warna untuk mewarnai garis pembatas bangun itu. 

 
Klik tombol Line style dan klik ketebalan dan gaya untuk garis itu. 

 

 

Grouping 
Definisi to group: To combine two or more objects to act as a single object, which 
you can then move or resize. (menggabungkan dua  objek atau lebih sehingga 
menjadi sebuah objek yang dapat dipindah atau diubah ukurannya.) 

Agar bisa mempraktikkan perintah group dan ungroup, kita harus sudah mempunyai 
minimal 2 objek dalam slide kita. 
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Langkah: 

1. Kita siapkan dua objek. Di sini sudah siap dua objek: segitiga dan segiempat. 

2. Kita klik tombol Select object  

3. Kita pilih objek yang mau kita group. Caranya kita klik halaman tempat 
gambar akan kita group, klik dan hold mouse dari pojok kiri atas, lalu kita 
drag sampai semua objek tercakup, lalu lepas tombol mouse. 

4. Inilah hasil select dua objek kita. 

5. Dari tombol Draw, pilih Group.  

6. Inilah hasilnya. Terbentuklah sebuah objek yang dapat kita pindah-pindah dan 
kita resize. 

Catatan: Objek yang sudah terlanjur di-group dapat kita ungroup dengan 
mengklik kanan objek itu lalu kita pilih ungroup. Perintah ungroup penting 
kalau kita ingin mengedit kembali objek penyusun dari objek itu. 
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Wordart 

 
 

Langkah 

1. Klik tombol Insert WordArt.  

2. Pilih WordArt yang diinginkan dari WordArt Gallery. 

3. Ketikkan teks Anda. 

4. Hasil tampilan teks di halaman PowerPoint 

5. Toolbar WordArt ini berfungsi untuk mengedit WordArt Anda. 
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Clipart 

 
Langkah: 

1. Klik tombol Insert Clip Art. 

2. Cari Clip art. Isikan Search for dengan kata, misalnya “home”. Lalu klik 
gambar yang ingin Anda masukkan ke halaman PowerPoint. 

 

Equation Editor 
Langkah: 

1. Buka dari menu Insert -> Object -> Pilih Object type: Microsoft Equation 
3.0. 

2. Muncul Equation Editor seperti gambar. 
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Contoh kasus memakai Equation Editor 

Untuk memudahkan pengertian, kita gunakan contoh rumus berikut. 

 

Langkah-langkah untuk membuatnya adalah: 

1. Sama dengan Langkah 1 di atas. 
2. sama dengan Langkah 2 di atas, muncul Equation Editor. Ketikkan y = 

3. Klik tombol Integral templates untuk menampilkan pilihan bentuk 
Integral. 

4. Klik tombol nomor 2 yang ada pada baris pertama, hingga tampilan 
berubah menjadi seperti gambar di bawah. 

5. Kemudian klik tombol Fraction and radical templates untuk menampilkan 
pilihan bentuk tanda akar dan pembagian (fraction) 

6. Klik tombol nomor 1 dari baris pertama pilihan, sehingga tampilan berubah 
menjadi seperti gambar 

7. Ulangi mengklik tombol Fraction and radical templates  

8. Klik tombol nomor 1 baris keempat, untuk menampilkan tanda akar. 
9. Klik tombol Fence templates , untuk menampilkan tampilan tanda 

kurung. 
10. Klik tombol nomor 1 dari baris pertama, untuk menampilkan tanda kurung, 

sehingga tampilan berubah seperti gambar. 
11. Ketik angka 5x3+2x2+1 
12. Sorot angka 3 pada 5x3 

13. Klik tombol subscript and superscript templates  
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14. Klik tombol nomor 1 dari baris pertama, untuk merubah angka 3 menjadi 
superscript. 

15. Kemudian ulangi langkah ini angka 2 pada 3x2. 
16. Tempatkan kursor di sebelah kanan tanda tutup kurung menggunakan tombol 

panah kanan di keyboard, kemudian ketik +. 
17. Klik tombol Summation templates  
18. Kemudian klik tombol nomor 1 dari baris untuk merubah tampilan seperti 

gambar. 
19. Ulangi langkah 9 dan 10 
20. Ketik x2+7 
21. Ulangil langkah 13 dan 14 untuk angka 2 pada x2. 
22. Pindahkan kursor dengan tombol panah bawah keyboard sampai ke tempat 

penyebut. 
23. Ketik angka 8x 
24. Pindahkan posisi kursor (dengan panah atas dan panah kiri) ke kotak atas 

yang terdapat di atas tanda integral, kemudian ketik angka 10. 
25. Pindahkan posisi kursor (dengan panah bawah agar sampai) ke kotak bawah 

yang terdapat di atas tanda integral, kemudian ketik angka 0. maka hasilnya 
akan seperti gambar di atas. 

26. Setelah jadi seperti ini, tekan menu File -> Exit and return to <xxxx>. 
27. Bila rumus kelihatan terlalu kecil, Anda bisa mengubah ukurannya dengan 

menggeret pojok-pojoknya dengan memakai mouse. 
28. Bila Anda ingin mengedit lagi, Anda dapat mengklik dobel ke rumus itu 

sehingga akan muncul lagi Equation Editor. 

 

 Hasil dari Langkah 4 dan seterusnya: 
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Gambar: Tahapan Pembuatan Rumus Dengan Equation Editor 

 

Tugas 
1. (Latihan) Buatlah 4 slide dengan ketentuan sebagai berikut: 

• slide pertama hendaklah berisi hasil dari praktik Drawing (termasuk grouping) 
• slide kedua hendaklah berisi hasil dari praktik WordArt  
• slide ketiga hendaklah berisi hasil dari praktik Clip Art 
• slide keempat hendaklah berisi hasil dari praktik Equation Editor 

2. (Kasus) Buatlah sebuah slide seperti di gambar berikut: 
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Teknik Penggunaan Efek Animasi Pada Slide Presentasi Powerpoint 
 
Tujuan: 

Setelah sesi ini peserta diharapkan dapat: 
1. mengetahui apa yang dimaksud dengan animasi dalam slide presentasi 

powerpoint dan manfaatnya 
2. membuat animasi sederhana baik untuk teks maupun gambar dalam slide 

presentasi powerpoint 
3. menggunakan animasi dalam slide presentasi powerpoint sebagai media 

pembelajaran dalam bidang studi masing-masing 
 
Pengertian animasi 

Presentasi multimedia yang baik tentunya harus dapat memberikan gambaran 
menyeluruh terhadapat materi yang ingin disampaikan kepada pemirsanya, sehingga 
tidak sekedar memindahkan tulisan di atas kertas ke dalam bentuk slide powerpoint. 
Dalam rangka memberikan materi pembelajaran yang baik terkadang kita harus: 
menyampaikan suatu proses, memperlihatkan urutan, memberikan gambaran cara 
kerja suatu sistem atau menjelaskan kejadian/fenomena alam. Hal-hal itu ternyata 
dapat disampaikan dalam slide presentasi powerpoint dengan menggunakan efek-
efek animasi yang fasilitasnya telah tersedia dalam software Microsoft Powerpoint. 

Kata animasi itu sendiri secara umum sebenarnya bermakna gambar bergerak. 
Tetapi dalam powerpoint tidak hanya gambar saja yang dapat kita beri efek animasi, 
obyek berupa teks juga dapat kita beri efek animasi. Sehingga pengertian animasi 
dalam powerpoint sebenarnya lebih mengacu pada bagaimana cara suatu obyek 
ditampilkan dalam slide presentasi powerpoint. 

Sebelum mengaplikasikan animasi pada slide presentasi ada beberapa hal 
yang perlu diperhatikan, yaitu: 
1. Jangan berlebihan dalam menggunakan animasi. Penggunaan animasi yang 

cenderung berlebihan akan membingungkan pemirsanya dan dapat 
mengaburkan isi presentasi. 

2. Sesuaikan animasi dengan isi presentasi, tujuan presentasi, pemirsa yang dituju 
dan tempat/lokasi presentasi. 

3. Perhatikan waktu yang disediakan. Penambahan efek animasi akan menambah 
durasi waktu setiap presentasi. Semakin banyak efek yang digunakan semakin 
banyak pula waktu yang diperlukan. 

4. Jangan terlalu banyak menggunakan efek suara pada animasi yang digunakan 
untuk presentasi oral, karena dapat memecah konsentrasi pemirsa. 

Uraian berikut akan menjelaskan fasilitas yang tersedia dalam program 
microsoft powerpoint serta cara penggunaannya untuk membuat animasi dalam slide 
presentasi powerpoint. Dalam modul ini juga akan disampaikan penggunaan obyek 
animasi alternatif seperti file GIF animasi yang dapat digunakan untuk memperkuat 
tampilan slide presentasi. Program microsoft powerpoint yang digunakan dalam 
modul ini adalah Microsoft Powerpoint 2003 dengan sistem operasi Microsoft 
Windows XP. 
 
Menu animasi pada Microsoft Powerpoint 2003 

Fasilitas untuk pembuatan animasi dalam powerpoint terdapat pada menubar 
slideshow.  
 

 
 



Klik menubar slideshow maka akan tampil sub-sub menu 
 

 
 
Terdapat tiga submenu untuk animasi yaitu: 
a. Animation schemes, yaitu skema animasi yang akan diterapkan untuk seluruh 

slide. Hal ini meliputi seluruh obyek yang terdapat pada slide dan efek transisi 
antar slide. Pada sub menu ini kita akan memilih satu model efek animasi yang 
akan diterapkan pada seluruh slide. 

b. Custom animation, menyediakan fasilitas untuk memilih dan mengatur efek 
animasi yang akan kita terapkan pada obyek di dalam slide. Dengan 
menggunakan sub menu ini kita akan lebih leluasa dalam menggunaka animasi 
sehingga diperoleh penerapan yang tepat, karena dalam suatu presentasi antara 
satu slide dengan yang lainnya tidak memiliki sifat yang sama.  

c. Slide Transition, mengatur efek animasi pada perpindahan antar slide. Hal ini 
dibahas di bagian lain dalam modul ini. 

 
Animation scheme 

Penggunaan animation scheme cukup mudah. Klik Slide Show > Animation 
Schemes, maka akan muncul animation schemes task pane di sisi kanan 
 

                    
 



Ada empat pilhan animation schemes, yaitu: No Animation (tidak ada efek animasi), 
Subtle (ada 13 efek animasi), Moderate (9 efek) dan Exciting (11 efek). Untuk 
mengaplikasikan caranya sebagai berikut: 
1. klik pada salah satu efek animasi 
2. klik play untuk melihat/preview tampilan efek tersebut 
3. klik Apply to All Slides, untuk mengaplikasikan efek tersebut pada seluruh slide 
 

 
 
Untuk menghapus/mengubah efek animasi, langkahnya adalah: 
1. Pilih slide yang akan diubah atau dihapus efeknya. 
2. Klik Slide Show > Animation Schemes > No Animation atau pilih efek yang lain 

untuk mengubahnya. 
 
Custom Animation 

Penerapan efek animasi lebih banyak menggunakan sub menu ini, karena 
lebih memberikan keleluasaan pada kita untuk memilih dan mngatur tampilan efek 
yang kita kehendaki. Klik Slide show > Custom Animation maka task pane 
Custom Animation akan muncul di kolom sebelah kiri layar 
 

             
 
Pada task pane tersebut terdapat beberapa tombol menu yang baru akan aktif jika 
kita telah memilih obyek pada slide yang akan diberi efek animasi. Efek animasi 



dapat kita berikan pada obyek apapun yang terdapat dalam slide, baik itu berupa 
teks, gambar maupun grafik, dengan cara yang sama. 

Terdapat empat kelompok animasi yang dapat kita pilih, yaitu: Entrance, 
Emphasis, Exit dan Motion Path. Kelompok Efek Entrance berisi berbagai pilihan 
efek pada obyek untuk muncul/tampil di layar. Kelompok efek Emphasis berisi efek 
untuk memberikan penekanan atau perhatian lebih pada suatu obyek. Kelompok Exit 
memberikan kita pilihan tampilan obyek untuk keluar/hilang dari layar slide. Motion 
Path akan memberikan kita kesempatan untuk menganimasikan obyek agar 
bergerak sesuai dengan jalur yang kita tetapkan, misal efek planet mengelilingi 
matahari, dsb. 

Langkah-langkah untuk memberi efek animasi adalah: 
1. klik obyek yang akan diberi efek animasi 
 

 
 
2. klik tombol menu Add Effect 
 

 
 
3. pilih kelompok animasi, misal Entrance 
 

 
 
4. pilih efek animasi yang ada di daftar atau pilih more effect 
 



 
 
5. Jika dipilih More effect maka akan muncul menu add entrance effect 
 

 
 
6. klik OK untuk mengaplikasikan atau cancel untuk membatalkan 
 
Jika efek animasi telah diaplikasikan maka pada task pane custom anmation akan 
muncul daftar obyek beserta urutannya 
 

 
 
Klik suatu obyek yang telah diberi efek animasi, maka pada task pane beberapa 
elemen pengaturan akan aktif dan dapat digunakan.  
 



 
 
Elemen tersebut di antaranya adalah: 
a. Start, mengatur saat animasi pada obyek mulai bekerja. Terdapat tiga pilihan: On 

Click (animasi dimulai pada saat tombol mouse di klik atau tombol keyboard di 
tekan), With Previous (animasi dimulai bersama-sama dengan efek sebelumnya) 
dan After Previous (animasi dimulai setelah efek sebelumnya selesai). 

 

 
 
b. Property, mengatur setting lanjutan pada jenis efek yang kita pilih. Misal pada 

efek Fly in property ini berupa Direction (arah obyek sewaktu muncul ke dalam 
layar). Tetapi tidak semua jenis efek memiliki property. 

 

 
 
c. Speed, mengatur kecepatan efek animasi sewaktu dijalankan. Ada lima pilihan 

kecepatan standar, yaitu: very slow, slow, medium, fast dan very fast. Pilih dan 
gunakan sesuai kebutuhan sewaktu melakukan presentasi.  

 

 



 
Keseluruhan elemen pengaturan di atas akan memberikan efek animasi yang sesuai 
dengan keinginan kita. 
 
Animasi motion path 

Motion path adalah efek animasi yang menggerakkan obyek mengikuti suatu 
alur (path) seperti garis, lengkungan, lingkaran, oval dan bahkan suatu alur yang kita 
buat sendiri (freeform). Langkah pembuatan efek animasi motion path adalah: 
1. Klik Slide Show > Custom Animation   
2. klik obyek yang akan diberi efek 
 

 
 
3. klik Add Effect 
 

 
 
4. arahkan mouse ke Motion Path, akan tampil  
 

 
 
5. Klik More Motion Path untuk melihat pilihan motion path yang lain 
6. Atur posisi obyek dan jarak motion path sesuai dengan gerakan dalam slide yang 

dikehendaki 
 

 
 



7. klik Play untuk melihat hasilnya 
 

 
 
Pengaturan urutan animasi 
Urutan jalannya animasi secara otomatis akan disesuaikan dengan urutan 
pemberian efek animasi pada obyek. Kita dapat mengatur ulang urutan ini dengan 
langkah-langkah: 
1. klik salah satu efek animasi yang telah dibuat, di dalam daftar pada task pane, 

yang ingin kita atur urutannya 
 

 
 
2. lihat menu Re-Order yang terletak di bagian bawah task pane 
 

 
 
3. pilih panah atas untuk memindahkan urutan animasi menjadi lebih dahulu atau 

panah bawah untuk sebaliknya. 
 
Pengubahan dan Penghapusan efek animasi 

Pengubahan efek animasi dapat dilakukan dengan langkah-langkah: 
1. klik salah satu efek animasi yang telah dibuat di dalam daftar pada task pane 
 

 
 
2. klik change 
 



 
 
3. pilih kelompok efek animasi  
4. pilih jenis efek baru yang diinginkan 

Penghapusan efek animasi dapat dilakukan dengan langkah-langkah: 
1. klik salah satu efek animasi yang telah dibuat di dalam daftar pada task pane 
 

 
 
2. klik remove 
 

 
 

Microsoft Powerpoint 2003 dapat menerapkan beberapa efek animasi pada 
satu obyek, tentunya dengan urutan penampilan efek yang berbeda. Untuk dapat 
menggunakan hal ini langkah-langkah yang harus dilakukan adalah : 
1. klik di area kosong untuk menonaktifkan pilihan pada salah satu efek animasi 

yang terdapat di dalam daftar pada task pane 
2. klik obyek yang akan diberi tambahan efek animasi 
3. klik Add effect 
4. pilih kelompok efek 
5. pilih jenis efek animasi yang diinginkan 
Pembuatan efek baru tetap akan dapat dilakukan walaupun obyek yang dipilih telah 
memiliki efek animasi. 
 
Menggunakan GIF Animasi 

File GIF animasi sebenarnya adalah file gambar dengan format GIF. 
Perbedaannya adalah file ini tidak memuat gambar statis tetapi gambar bergerak. 
Slide powerpoint dapat memuat gambar dengan format ini sehingga dapat digunakan 
untuk memperindah atau memperkuat slide sewaktu dijalankan. Pilih gambar animasi 
yang sesuai dengan isi dan tujuan slide, selain itu jangan menggunakan terlalu 
banyak gambar sebab justru akan membingungkan pemirsa. 

Untuk menambahkan gambar GIF animasi dilakukan langkah-langkah sebagai 
berikut: 
1. Pilih slide yang akan diberi gambar GIF animasi 
2. Klik Insert > Picture > From File  
 



 
 
3. Pilih lokasi dimana file GIF animasi tersimpan kemudian pilih filenya lalu klik insert  
 

 
 
4. Atur ukuran dan posisi gambar sehingga sesuai dengan isi slide 
 

 
 
5. Gambar animasi telah terpasang, tetapi tidak akan terlihat pada mode normal. 

Gambar itu baru akan terlihat jika slide dijalankan dalam menu Slide Show, 
seperti pada contoh berikut ini. 



 

 
 

 
 

 
 

 
 
Penerapan animasi dalam pembelajaran 

Prinsip dasar penggunaan animasi telah dipelajari di atas. Penerapan prinsip-
rinsip tersebut dapat menghasilkan sesuatu yang menarik atau berguna bagi 

aran. Sebagai contoh dapat dilihat pada 
bebera

p
kepentingan penyampaian materi pembelaj

pa kasus berikut ini: 
 

I. Animasi teks sederhana untuk memperlihatkan pembagian/klasifikasi 
Akan disampaikan definisi dan klasifikasi standar pengukuran seperti pada slide 
berikut 
 

 
 
Kita dapat menggunakan efek animasi fly in atau appear untuk memunculkan teks 
dan obyek berupa panah satu per satu, sehingga masing-masing istilah dapat 
ijelaskan satu persatu. Langkah yang harus dilakukan adalah k  Slide Show > d lik



Custom Animations kemudian pilih masing-masing obyek lalu atur efek animasi 
beserta property dan speed-nya masing-masing.  
 

 
 
Perhatikan pada bagian kiri masing-masing obyek akan muncul angka. Angka 
tersebut memperlihatkan urutan animasi yang akan tampil. 
 

 
 

 
Pada task pane custom animation akan terlihat 

 
 
Klik play apakah untuk melihat apakah efek animasi, kecepatan dan urutannya 
telah sesuai atau belum. Klik panah di sebelah kiri atau kanan menu Re-Order 
ntuk menatur urutannya. 

II. 

u
 
Animasi gambar revolusi bulan terhadap bumi 



Buat beberapa obyek untuk mewakili bumi, bulan dan lintasan bulan. Jika ada
akan lebih baik jika menggunakan gambar fo

 
to bumi dan bulan. Obyek untuk 

bulan dibuat sebanyak yang diinginkan, semakin banyak pergeseran posisinya 
dapat dibuat semakin halus. Tempatkan obyek-obyek tersebut seperti gambar 
slide berikut. Beri keterangan seperlunya. 
 

 
 
Klik Slide Show > Custom Animation, lalu klik obyek bulan yang berada tepat 
disebelah kanan bumi, kemudian pada task pane custom animation klik add 
effect > entrance > appear. Pada task pane akan muncul daftar animasi untuk 
obyek tersebut. Agar bulan tampak berpindah posisi maka trik yang harus 
dilakukan adalah klik kanan di atas daftar animasi obyek bulan tersebut, 
kemudian pilih effect options  
 

 
 
Akan muncul kotak dialog appear, klik pilihan After animation, pilih Hide on next 
Mouse click.  
 



 
 
Lakukan langkah di atas untuk seluruh obyek bulan berturutan dengan urutan 
berlawanan arah jarum jam.  
 

 
 
Klik Slide Show > View show untuk melihat hasilnya.  
Animasi ini masih dapat dikembangkan dengan memberikan tanda gerakan rotasi 
dan tanda panah untuk memperlihatkan bahwa permukaan bulan yang 
menghadap bumi selalu sama. Bulan juga dapat dibuat seolah-olah bergerak 
sendiri dengan mengatur pilihan Start menjadi After Previous, untuk obyek bulan 
kedua dan seterusnya. 
Animasi semacam ini juga dapat dibuat dengan menggunakan efek Motion Path, 
bahkan akan terasa lebih mudah karena tidak perlu membuat banyak obyek 
bulan tetapi cukup satu saja. Silakan dicoba! 

 
Tugas 

1. Buat satu set slide presentasi powerpoint dengan menggunakan animasi teks 
untuk menjelaskan urutan langkah kerja pada satu topik sesuai dengan 
bidang studi masing-masing 

2. Buat satu set slide presentasi powerpoint dengan menggunakan animasi 
gambar untuk menjelaskan suatu proses pada satu topik sesuai dengan biang 
studi masing-masing 
 



Video Editing Menggunakan Windows Movie Maker 
 
 
 
Pengantar Video Editing 

Sejalan dengan berkembangnya teknologi komputer maka teknologi media juga 

maju pesat. Terutama teknologi multimedia yang menjadi fokus pembicaraan saat 

ini hamper tiap jam bahkan mungkin tiap menit mengalami perkembangan. Dampak 

dari perkembangan ini tidak hanya dari sisi kecanggihannya tapi juga secara 

ekonomis, kemudahan dalam penggunaan, dan kemanfaatan. Oleh karena itu 

sekarang dapat dilihat bahwa produksi multimedia sangat beragam baik bentuknya 

maupun aplikasinya dalam segala sendi kehidupan. Contoh, dunia entertainment 

dengan sinetron dan video clips, dunia rumah tangga dengan home theater‐nya, dunia 

pendidikan dengan CAI, CBI, e‐learning, dan masih banyak lagi. Oleh karena itu pada 

kesempatan ini kita coba mengulas tentang Windows Movie Maker.  

Windows Movie Maker adalah sebuah program komputer yang dibawa oleh Windows 

™ (Microsoft), jadi hampir setiap komputer dengan memakai Operating System 

Windows ada program ini. Pada masa ini hampir banyak sekolah sudah mempunyai 

laboratorium komputer, dengan demikian diharapkan apabila menguasai program 

ini dikemudian hari akan mudah untuk mengembangkannya. Selain itu program ini 

penggunaannya sangatlah mudah, bisa dikatakan bahwa dalam waktu 2 jam ini 

(keluar ruangan ini) anda sudah dapat mengedit suatu video clip, dengan catatan 

stock shoot‐nya (potongan‐film) sudah tersedia. Harapan selanjutnya sebagai seorang 

pengajar bisa membuat. mengembangkan program‐program multimedia yang akan 

sangat mendukung dalam proses belajar mengajar (sesuai target workshop ini ☺). 

Proses editing suatu video clip ataupun film minimal yang dibutuhkan adalah: 

1. Memotong atau menyuplik gambar video (video cutting); hal ini berguna untuk 

memilih frame‐frame yang dibutuhkan, karena belum tentu semua frame dalam 

stock shoot itu dibutuhkan semua. 
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2. Menyusun ulang gambar video sesuai script skenario (video combining); proses 

editing yang paling pokok disini, karena hasil video clip atau film tergantung 

dalam proses ini. 

3. Membuat perantara atau transisi dari satu frame ke frame berikutnya (video 

transitions); proses ini dibutuhkan selain untuk menghasilkan tayangan yang 

enak dilihat juga digunakan untuk mengatasi proses jumping yang sering 

dihadapi oleh editor video clip atau film. 

4. Membuat efek khusus (video effects); dalam proses ini sebetulnya termasuk dalam 

proses animasi walaupun kadang bisa lebih spesifik pada penekanan konsep 

bukan pada hasil gambar. 

Semua kemampuan ini bisa didapatkan dalam Windows Movie Maker, jadi program 

ini telah dapat dipakai untuk membuat dan mengembangkan aplikasi multimedia.  

Windows Movie Maker  

Untuk mengakses program ini biasanya ada di accessories, cara mencarinya dengan 

mengarahkan kursor ke start, klik (tombol kiri) start, kemudian akan muncul menu. 

Selanjutnya arahkan kursor ke All Programs ‐> Accessories ‐> Windows Movie Maker 

dan kemudian klik (tombol kiri). Setelah diaktifkan maka akan terlihat area kerja 

Windows Movie Maker. Fasilitas yang dipunyai oleh program ini dapat dilihat dari 

menu‐menu yang ada di bar (deretan) paling atas setelah header. Apabila kursor 

diarahkan ke menu‐menu tersebut maka menu tersebut akan aktif dan jika di klik 

(tombol kiri) maka akan muncul sederetan menu (pull down menu), masing‐masing 

pilihan dalam pull down menu tersebut merupakan fasilitas‐fasilitas yang 

dipunyainya. Apa saja fungsi dari fasilitas tersebut dapat dilihat dalam menu Help. 

Menu ini sangatlah membantu bagi user yang menjalankan program komputer. 

Sebenarnya kalau user tahu fasilitas Help ini amatlah lengkap, asal kita membacanya 

teliti maka akan ditemukan semua fungsi diperlukan. 

Satu kata kunci yang dibutuhkan dalam menggunakan program komputer adalah 

Learning by doing, tidak ada cara lain selain mencoba dan mencoba (tidak mungkin 
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belajar komputer hanya membaca buku tanpa mencoba, kecuali …. ). Belajar dari 

kesalahan untuk menemukan yang benar merupakan modal utama. Hal lain yang 

diperlukan adalah pola pikir sebab‐akibat, karena komputer merupakan alat (tool) 

yang tidak akan mungkin ada akibat tanpa sebab, atau sebab tertentu akan 

membawa akibat. 

Area Kerja Windows Media Maker 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pemasukan Gambar 

Untuk memasukkan gambar yang akan disunting (edit) melalui Movie Tasks ‐> 

Capture Video. Ada pilihan: 

• Capture from video device, mengambil gambar dari alat perekam video seperti 

kamera video maupun photo baik analog maupun digital 

• Import video, memasukkan gambar video dari file dengan digital video format (avi, 

mpeg, wmv, dan sebagainya) 

• Import pictures, memasukkan gambar photo dari file yang sudah ada, tentunya 

dengan format gambar photo seperti bmp, jpg, gif, dan sebagainya 

Video Editing  3 



• Import audio or music, memasukkan suara tentunya dengan digital sound format, 

seperti voc, wav, mp3, dan sebagainya. 

Pilih salah satu dari menu tersebut yang sesuai dengan jenis gambar yang akn 

disunting. Gambar yang diimport tersebut akan masuk dalam window collection yang 

berada ditengah dari area kerja Windows Media Maker.  

 

 

Setelah semua gambar ada di window collection maka untuk menyungtingnya ditata 

dalam window stroryboard (terletak paling bawah). Cara menatanya amat mudah 

yaitu gambar yang akan ditata diambil dari window collection, dengan cara kursor 

menunjuk gambar dan klik (tombol kiri) maka gambar yang ditunjuk akan ada 

lingkaran biru (blue border). Kemudian untuk memindahkan gambar tersebut ke 

window stroryboard dengan cara didrag yaitu klik (tombol kiri) pada gambar tersebut 

jangan dilepas dulu penekanan tombolnya, lalu geser kursor diarahkan ke window 

storyboard setelah itu baru tombol dilepas. Proses diatas akan berulang untuk menata 

gambar berikutnya sesuai denga script.  Contoh hasilnya seperti berikut : 
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Proses Pemotongan Gambar 

Gambar yang telah masuk distoryboard jika ingin dipotong, tinggal menentukan 

bagian mana yang akan dipisahkan lalu lakukan perintah split dari menu. Namun 

sebelumnya perlu diubah dari menu stroryboard ke menu timeline, karena dengan 

menu timeline akan lebih mudah menentukan bagian mana yang akan dipotong. 

Pengubahan menu ini tinggal klik (tombol kiri) pada tulisan show storyboard atau 

show timeline.  

Setelah ditentukan timeline mana yang akan dipotong lalu pilih menu Clip ‐> Split, 

maka gambar akan terbagi menjadi dua bagian tinggal pilih mana yang dipakai 

selanjutnya. Simpel bukan ?  

Proses Penyusunan Gambar 
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Proses penyusunan seperti pada proses pemasukan gambar, hanya semua gambar 

ditata atau disusun di window stroryboard atau window timeline sehingga membentuk 

satu alur cerita seperti skenario yang dikehendaki. Jika terjadi kesalahan susunan 

gambar maka dengan mudah gambar yang salah dihapus (delete) dan disisipi (insert) 

gambar lain.  

 

Proses penghapusan gambar pada storyboard dengan mengaktifkan gambar tersebut 

yaitu klik (tombol kiri) gambar yang akan diganti. Setelah aktif klik (tombol kanan) 

maka akan muncul pilihan diantaranya ada yang untuk delete, arahkan kursor ke 

pilihan tersebut kemudian klik (tombol kiri) maka gambar akan terhapus dari 

storyboard.  

Sedangkan proses penyisipan (insert) sama seperti proses pemasukan gambar ke 

window storyboard yaitu dengan mendrag gambar yang ada di window collection.  

Proses Penambahan Title atau Credit 

Proses penambahan Title maupun Credit ini mekanismenya seperti proses insert 

gambar. Pertama apabila masih dalam mode storyboard ubah dulu ke mode timeline, 

kemudian pilih diposisi mana akan disisipkan text.  
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Setelah dipilih maka tinggal klik make titles or credits pada Movie Task Edit Movie. 

Kemudian ada 5 pilihan silahkan pilih salah satu, jika pilihan tersebut kurang sesuai 

dengan yang dikehendaki dikemudian masih bisa diedit lagi. Selanjutnya tulis text 

yang dikehendaki, pilih animasi apa yang dikehendaki (ada banyak sekali), juga bisa 

dipilih font dan color yang sesuai. Sebelum dilanjutkan dicoba dulu apakah hasilnya 

sudah sesuai dengan yang diiginkan, apabila belum maka diperbaiki dahulu, sampai 

cocok dengan yang dimaksud.  Lihat gambar berikut : 
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Proses Transitions dan Effects 

Proses ini hampir mirip dengan yang proses lain di atas namun proses ini dilakukan 

setelah ada gambar di storyboard. Dan prosesnya amat sederhana tinggal pilih menu 

transition atau effect,  lalu pilih model yang mana ?, drag diantara gambar yang 

dikehendaki. Proses ini bisa diulangi untuk hal yang lainnya. Pemilihan model 

transitions maupun effects sangat mempengaruhi hasil tayangan, cocok apa tidak ?. 

Jadi perlu dipertimbangkan secara masak. Transition dan effects biasanya untuk 

mengatasi agar tidak terjadi jumping antara frame‐frame yang disusun dalam movie. 

Hal ini bisa terjadi karena stock shot susah mendapatkan angle yang pas atau bisa juga 

karena timing yang tidak didapat. Dengan transition dan effects maka secara 

keseluruhan konsep yang akan dipaparkan tetap terjaga, tidak putus bahkan 

mungkin mengaburkan apa yang harus disampaikan dalam pesan media tersebut. 

Proses Penyimpanan (Save) 

Setelah selesai melakukan editing maka hasil video yang dibuat harus disimpan. 

Proses penyimpanan sangat sederhana, pada Movie Task Finish Movie ada pilihan 

Save to my computer, pilihlah itu. Jika hal itu dilakukan maka akan muncul Save Movie 
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Wizard. Kemudian akan ditanya apa nama file‐nya dan di folder mana hendak 

 

disimpan, seperti gambar berikut.  

Sesudah diisi lalu tekan tombol next, lalu akan dipersilahkan untuk memilih movie 

setting. Dalam hal ini hanya ada dua pilihan yaitu format MWV atau format AVI, 

dengan berbagai pilihan display size, aspect ratio, bit rate, dan frame per second. 



Berikutnya tinggal klik tombol next tunggu proses penyimpanan dan selesai. 

Pembuatan Multimedia 

Beberapa hal dalam pembuatan multimedia adalah: 

1. Buatlah desain mulai dari topik, script, dan storyboard 

2. Dicobakan dikalangan terbatas untuk mencari masukan dari multimedia yang 

anda buat 

3. Lakukan analisis dari masukan tersebut, rombaklah bilamana perlu tidak perlu 

ragu untuk mendapatlah hasil yang optimal 

4. Kemaslah dalam bentuk yang praktis, ekonomis, dan bermanfaat. 
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Image Download dan Image Editing 
 
 
 
Download dari Digital Camera 

Memindahkan gambar dari digital camera sangatlah simple, semudah mengcopy file 

dari flashdisk maupun CD. Ada dua cara untuk memindahkan data dari digital camera 

ke komputer :  

1. Hubungkan digital camera dengan komputer melalui data cable, setelah terhubung 

hidupkan digital camera, maka di komputer akan terlihat directory/folder baru. 

Apabila telah terlihat folder baru proses selanjutnya seperti mengcopy file biasa. 

2. Cara yang kedua lepas memory card yang ada di digital camera lalu masukkan di 

card reader yang ada di komputer, apabila benar maka akan muncul folder baru. 

Setelah itu maka seperti proses selanjutnya seperti mengcopy file biasa. 

Jadi untuk memindahkan image dari digital camera ke komputer sangatlah mudah 

tidak sesulit yang dibayangkan. Untuk itu apabila menghendaki foto‐foto untuk 

dicreate menjadi media presentasi tidak ada kesulitan lagi. Begitu pula memindahkan 

image dari scanner sama mudahnya dengan memakai digital camera, terutama jika 

menggunakan Windows XP karena sudah tersedia driver‐driver yang dibutuhkan 

untuk menjalankan peralatan tersebut. 

Image Editing 

Software yang digunakan Microsoft Office Picture Manager. Program ini amat 

sederhana tetapi apabila yang dibutuhkan hanya untuk memperkecil maupun 

memperbesar image cukup memadai. Kemampuan lain dalam image editing adalah :  

1. Export ke format lain misal dari format BMP ke format JPG 

2. Mengatur brightness dan contrast suatu image 

3. Mengatur warna suatu image lewat kemampuan color editing 

4. Mengatur posisi dan letak gambar dengan fasilitas rotate dan flip 

5. Serta memotong image dengan crop 
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6. Selain itu juga punya kemampuan melakukan kompresi sehingga image yang 

dihasilkan hanya membutuhkan memori yang kecil saja sesuai kebutuhan. 

Dengan kemampuan di atas sudah cukup apabila memerlukan  beberapa image 

untuk pembuatan media pembelajaran atau media presentasi. 
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HANDOUT 10 
TABEL, DIAGRAM DAN GRAFIK 

 
 
A. TABEL (TABLE) 

Contoh slide dengan komponen tabel seperti pada Gambar 10.1. 

 

 
Gambar 10.1. Contoh Slide dengan Tabel 

Buat slide baru dengan title menggunakan Wordart bertuliskan “Peserta Pelatihan ICT” 
dan sisipkan gambar (clipart) yang saudara pandang presentatif, serta atur tataletaknya. 
Sebagai contoh dapat dilihat pada Gambar 10.1. 

 
1.  Menyisipkan Tabel. 

a. Pada slide yang terpilih/diinginkan, lakukan penyisipan tabel, dengan cara: 
• Melalui menu Insert > Table (Gambar 10.2.a.), atau 

 

Submenu Sisip Diagram 

Submenu Sisip Grafik 

Gambar 10.2.a. Menu Insert > Table 



• Melalui toolbar atau pada slide yang ada konten grafiknya, klik ikon  (Insert 
Table); Gambar 10.2.b. 

 

 Ikon Sisip Tabel 

Gambar 10.2.b. Ikon Insert Table 

 

b. Tentukan dimensi tabel yang diperlukan (misal 4 baris 3 kolom). Gambar 10.2.c. 

 

   

 
  

 

 
Gambar 10.2.c. Pengisian dimensi tabel 

 Klik Table dari menu Insert 

 Isikan jumlah kolom 

 Isikan jumlah baris 

 Klik tombol OK 
 

Dihasilkan penyisipan tabel seperti Gambar 10.3. 
 

 

Tabel 3 Kolom 4 Baris 

Gambar 10.3. Hasil Penyisipan Tabel 3 Kolom 4 Baris 

2.  Mengisi Sel Tabel. 
c. Isi sel-sel pada tabel yang bersesuai dengan ketentuan: 

• Kolom 1, tuliskan NO 
• Kolom 2, tuliskan NAMA 
• Kolom 3, tuliskan ASAL SEKOLAH 
• Contoh data isian ambil dari nama dan asal sekolah peserta yang ada. 

 



 
Gambar 10.4. Hasil Pengisian Tabel 

 
3.  Mengatur (Format) Tabel. 

d. Atur lebar kolom (maupun tinggi baris) agar isian sel tertata rapi. Cara seperti 
diilustrasikan pada Gambar 10.5. 

 

 
Gambar 10.5. Cara Atur Lebar Kolom 

 
Letakkan pointer mouse di atas garis pemisah kolom (atau 
baris). Pointer akan berubah menjadi double-sided arrow. 

 
Click&Drag gerakkan ke kanan atau ke kiri sampai diperoleh 
lebar kolom yang diharapkan. Untuk atur tinggi baris, gerakkan 
ke atas atau ke bawah. 

 
Lepaskan penekanan tombol mouse, lebar kolom atau tinggi 
baris telah disesuaikan. 

 
e. Atur jenis dan ukuran huruf, serta format dan perapiannya sesuai dengan yang 

diinginkan (agar lebih tertata saat ditampilkan). 
• Untuk nama kolom (header); tebal (bold) dan posisi di rapi tengah (center). 
• Untuk semua data isian; ukuran (size) huruf 18, tebal (bold), dan warna (color) 

biru. 
• Untuk data isian NO (kolom 1), posisi rapi kanan (right) 

 
f. Ubah jenis (style), ketebalan (width), dan warna (color) garis tepi (border) tabel 

sesuai dengan yang diinginkan (agar lebih terbaca dan menarik). Cara seperti 
diilustrasikan pada Gambar 10.6.a. 

 



 
Gambar 10.6.a. Cara Atur Garis Tepi (Border) Tabel 

 Click&Drag sel yang akan diatur garis tepinya 

 Klik tombol Tables and Borders 

 
Pada toolbar Tables and Borders, klik panah drop-down Border 
Style 

 Klik jenis garis tepi dari daftar pilihan yang ada 
 

g. Ubah warna latar belakang sel (fill) untuk nama kolom (baris 1) sesuai dengan yang 
diinginkan (agar lebih fokus dan menarik). Cara seperti diilustrasikan pada Gambar 
10.6.b. 

 
 

 
Gambar 10.6.b. Cara Ubah Warna Latar (Color Fill) Sel 

 Click&Drag sel yang akan diatur warna latarnya 

 Klik tombol Tables and Borders 

 
Pada toolbar Tables and Borders, klik panah drop-down Color Fill. 
Klik warna dari daftar pilihan yang ada 

 Warna latar dari sel yang dipilih telah berubah 
 

Untuk efek pengisian (Fill Effects) tersedia pilihan format, yaitu: gradient, texture, 
pattern, dan picture (Gambar 10.6.c.).  



 
Gambar 10.6.c. Pilihan Efek Warna Latar (Color Fill) Sel 

 
3.  Menyisipkan Kolom atau Baris. 

Karena suatu hal, saat mengolah tabel tidak tertutup kemungkinan muncul penambahan 
kolom maupun baris baru. Cara seperti diilustrasikan pada Gambar 10.7. 

 
 

 
Gambar 10.7. Cara Penyisipan Kolom 

 

 
Click&Drag kolom yang mana sebelah kanannya akan disisipi kolom 
baru 

 Pada kolom yang telah diblok, klik kanan tombol mouse 

 Dari menu shortcut yang muncul, klik Insert Columns 

 Kolom baru ditambahkan sebelah kanannya 
 

Untuk menyisipkan baris, caranya analogi dengan penyisipan kolom. Penyisipkan 
dilakukan dengan pengeblokan baris dimana penyisipan akan dilakukan yang dilanjutkan 
dengan memilih insert rows di menu shortcut. 

 
 



3.  Mengabung dan Memecah Sel. 
Untuk kepentingan penyajian data yang lebih presentatif, khususnya untuk tabel dengan 
isian data majemuk, diperlukan langkah penggabungan (merge) atau pemecahan (split) 
sel. Cara seperti diilustrasikan pada Gambar 10.8.a. dan Gambar 10.8.b. 

 
 

 
Gambar 10.8.a. Cara Menggabung Sel (Merge Cells) 

 Click&Drag sel yang akan digabung 

 Klik tombol Tables and Borders 

 Pada toolbar Tables and Borders, klik tombol Merge Cells 

 Sel terpilih telah digabung menjadi 1 sel 
 
 

 
Gambar 10.8.a. Cara Memecah Sel 

 Click&Drag sel yang akan dipecah 

 Klik tombol Tables and Borders 

 Pada toolbar Tables and Borders, klik tombol Split Cell 

 Sel terpilih telah dipecah menjadi 2 sel 
 

 
 
 



B. BAGAN ORGANISASI (ORGANIZATION CHART) 
Contoh slide dengan komponen bagan organisasi seperti pada Gambar 10.9. 

 

 
Gambar 10.9. Contoh Slide dengan Bagan Organisasi 

Buat slide baru dengan title menggunakan Wordart bertuliskan “Bagan Organisasi 
Pelatihan ICT” dan sisipkan gambar (clipart) yang saudara pandang presentatif, serta atur 
tataletaknya. Sebagai contoh dapat dilihat pada Gambar 10.9. 
 
1.  Menyisipkan Bagan Organisasi. 

a. Pada slide yang terpilih/diinginkan, lakukan penyisipan tabel, dengan cara: 
• Melalui menu Insert > Diagram (Gambar 10.2.a.), atau 

• Melalui toolbar atau pada slide yang ada konten grafiknya, klik ikon  (Insert 
Diagram or Organizational Chart); Gambar 10.10.a. 

 

 

Ikon Sisip Diagram 
atau Bagan Organisasi 

Gambar 10.10.a. Ikon Insert Diagram or Organizational Chart 

 

b. Pilih tipe diagram untuk Bagan Organisasi melalui Diagram Gallery. Cara seperti 
diilustrasikan pada Gambar 10.10.b. 

 
Gambar 10.10.b. Pemilihan Tipe Diagram Bagan Organisasi 



 Klik ikon Insert Diagram 

 Klik tipe Organization Chart pada kotak dialog Diagram Gallery 

 klik tombol OK 

 Diagram bagan organisasi telah disisipkan 
 
2.  Mengisi Bagan Organisasi. 

c. Pada masing-masing bagian (shape), isikan nama orang yang inginkan dalam 
susunan organisasi. Cara seperti diilustrasikan pada Gambar 10.10.c. 

 
Gambar 10.10.b. Pemilihan Tipe Diagram Bagan Organisasi 

 Klik shape dan ketikkan isinya 
 
3.  Pengembangan Bagan Organisasi. 

d. Kondisi awal bagan hanya terdiri dari 4 shape dalam 2 level. Pada kenyataannya 
bagan organisasi tidak sesederhana seperti kondisi awal. Untuk itu perlu pengem-
bangan dengan penambahan: subordinate, coworker, maupun assitant. Adapun 
penyisipannya melalui menu Organization Chart (Gambar 10.11.a.) 

 

 
Menu

Gambar 10.11.a. Menu Organization Chart 

Penyisipan dimulai dengan mengaktifkan/memilih bagian (shape) yang akan 
dikembangkan. Selanjutnya, melalui menu Organization Chart lakukan penyisipan 
yang diingin. Salah satu contoh penambahan subbagian seperti diilustrasikan pada 
Gambar 10.11.b. 

 
Gambar 10.11.b. Menyisipkan Subordinate 



 
Setelah shape yang akan dikembangkan terpilih, dari menu 
Organization Chart, klik Insert Shape > Subordinate 

 Shape subordinate telah ditambahkan 
 
3.  Mengatur (Format) Bagan Organisasi. 

e. Untuk menghasilkan bagan yang baik diperlukan pengatur proporsi dan bentuk shape 
yang digunakan. Proporsi bagan diatur melalui tempat penampung (placeholder) 
dengan cara click&drag pada titik tepi tempat penampung. Adapun cara untuk 
memilih bentuk shape melalui menu Autoformat (lihat Gambar 10.11.a) untuk 
selanjutnya memilih bentuk (Diagram Style) yang diinginkan Gambar 10.12. 

 

 
Gambar 10.12. Galeri Bentuk Bagan Organisasi (Style Gallery) 

 
 
C. GRAFIK (CHART) 

Contoh slide dengan komponen grafik seperti pada Gambar 10.13. 

 

 
Gambar 10.13. Contoh Slide dengan Grafik (Chart) 

Buat slide baru dengan title menggunakan Wordart bertuliskan “Nilai Peserta Pelatihan 
ICT” dan sisipkan gambar (clipart) yang saudara pandang presentatif, serta atur 
tataletaknya. Sebagai contoh dapat dilihat pada Gambar 10.13. 
 
1.  Menyisipkan Grafik (Chart). 

a. Pada slide yang terpilih/diinginkan, lakukan penyisipan tabel, dengan cara: 
• Melalui menu Insert > Chart (Gambar 10.2.a.), atau 



• Melalui toolbar atau pada slide yang ada konten grafiknya, klik ikon  (Insert 
Chart); Gambar 10.14.a. 

 

 
Ikon Sisip Grafik 

Gambar 10.14.a. Ikon Insert Chart 

Akan disisipkan grafik yang terdiri dari tempat penampung grafik (chart)  dan 
lembar data (datasheet) seperti pada Gambar 10.14.b. 

 

 
Gambar 10.14.b. Chart dan Datasheet 

 
2.  Mengisi Sel Datasheet. 

b. Pada slide awal perlu dilakukan penyesuaian untuk penyajian data yang sebenarnya. 
Pemasukan data dilakukan pada sel datasheet. Cara seperti diilustrasikan pada 
Gambar 10.14.c. 

 
 

 
Gambar 10.14.c. Mengisi Sel Datasheet 

 

 Klik ganda area chart untuk mengaktifkan lembar datasheet 

 Isikan data pada sel yang bersesuaian di lembar datasheet 
 
 



2.  Mengatur Grafik. 
c. Pengaturan lebih lanjut diperlukan untuk penampilan grafik yang lebih menarik. Pada 

obyek bagian dari grafik lakukan klik ganda untuk menampilkan jendela pengaturan. 
Salah satu contoh pengaturan bentuk batang grafik seperti Gambar 10.15. 

 

 
Gambar 10.14.c. Mengisi Sel Datasheet 

 
 
PENGAYAAN 
D. Import Grafik (Chart) dari Microsoft Excel 

Adakalanya, untuk membuat grafik yang lebih luwes, pengguna Powerpoint lebih suka 
dengan cara mengimport dari Microsoft Excel. Adapun caranya seperti diliustrasikan 
Gambar 10.15. 

 

 
Gambar 10.15. Penyisipan Obyek Microsoft Excel Chart 

 

 Klik submenu Object dari menu Insert 

 Pada kotak dialog Insert Object, pilih Microsoft Excel Chart. Klik OK 

 Kllik tabulasi Sheet1 

 Isikan data pada sel yang bersesuaian 



Untuk mengatur tampilan grafik dapat dilakukan melalui toolbar Chart seperti Gambar 
10.16. 

 
Gambar 10.16. Toolbar Chart 

 
E. Animasi Penampilan Grafik (Chart) 

Untuk meningkatkan cara memunculkan tabel secara lebih “hidup”, dapat diterapkan 
animasi. Berikut tahapannya: 

1. Buat tabel dengan menggunakan Microsoft Excel. 

2. Buat grafik yang diinginkan berdasarkan data tabel yang ada. 

3. Pilih grafik dan copy 

4. Pindah pada slide Powerpoint yang akan ditambah grafik, lakukan paste. 

5. Pilih grafik yang akan dikenai animasi penampilan, lakukan Draw > Ungroup. 

6. Grafik yang telah di-ungroup ditandai banyaknya node. Buang bagian yang tidak 
diperlukan.  

7. Pilih (kumpulan) obyek yang akan dikenai efek kemunculannya, dilakukan melalui 
menu Slide Show > Custom Animation. Pada Task Panel Custom Animation klik 
Add Effect > Entrance. 
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